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Chapter 1 Introduction
Mira is a versatile security management software for TRENDnet IP cameras and NVRs. This software
provides multiple functionalities, including real‐time live view, video recording, remote search and
playback, file backup, alarm receiving, security control, time & attendance, etc., for the connected
devices to meet the needs of monitoring task. With the flexible distributed structure and easy‐to‐
use operations, the client software is widely applied to the surveillance projects of medium or small
scale.
This user manual describes the functions, configurations and operation steps of the client software.
To ensure the properness of usage and stability of the software, refer to the contents below and
read the manual carefully before installation and operation.
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Chapter 2 Management
You can manage devices on the client, including adding, editing, and deleting the devices.

2.1 Activate Devices
For some devices, you are required to create the password to activate them before they can be
added to the software.
Before You Start
Make sure the device to activate is connected to the network and is in the same subnet as the PC
running the client.
Steps
Note
This function should be supported by the device.
1. Enter the Device Management page.
2. Click Device tab on the top of the right panel.
3. Click Online Device to show the online device area at the bottom of the page.
The searched online devices are displayed in the list.
4. Check the device status (shown on Security Level column) and select an inactive device.
5. Click Activate to open the Activation dialog.
6. Create a password in the password field, and confirm the password.
Caution
The password strength of the device can be automatically checked. We highly recommend you
change the password of your own choosing (using a minimum of 8 characters, including at least
three kinds of following categories: upper case letters, lower case letters, numbers, and special
characters) in order to increase the security of your product. And we recommend you reset your
password regularly, especially in the high security system, resetting the password monthly or
weekly can better protect your product.
Proper configuration of all passwords and other security settings is the responsibility of the
installer and/or end‐user.
7. Optional: For the NVR device connecting with inactive network camera(s), create a password in
Network Cameras' Default Password field and enter the confirm password for activating the
network camera(s) via NVR.
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2.2 Add Device
After launching the client, devices including network cameras, video encoders, DVRs, NVRs, access
control devices, alarm devices, video intercom devices, etc., should be added to the client for the
remote configuration and management, such as live view, playback, event management, access
control, etc.

2.2.1 Add Online Device
The active online devices in the same local subnet with the client software will be displayed on the
Online Device area. You can click Refresh Every 60s to refresh the information of the online
devices.

Add an Online Device
You can add an online device to the client.
Steps
1. Enter the Device Management module.
2. Click Device tab on the top of the right panel.
3. Click Online Device to show the online device area.
The searched online devices are displayed in the list.
4. Select an online device from the Online Device area.
Note
For the inactive device, you need to create the password for it before you can add the device
properly. For detailed steps, refer to Activate Devices.
5. Click Add to open the device adding window.
6. Enter the required information.
Name
Enter a descriptive name for the device.
IP Address
Enter the device's IP address. The IP address of the device is obtained automatically in this
adding mode.
Port
The port number of the device is obtained automatically in this adding mode.
User Name
By default, the user name is admin.
Password
Enter the device password.
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Caution
The password strength of the device can be automatically checked. We highly recommend
you change the password of your own choosing (using a minimum of 8 characters, including
at least three kinds of following categories: upper case letters, lower case letters, numbers,
and special characters) in order to increase the security of your product. And we recommend
you reset your password regularly, especially in the high security system, resetting the
password monthly or weekly can better protect your product.
Proper configuration of all passwords and other security settings is the responsibility of the
installer and/or end‐user.
7. Check Synchronize Time to synchronize the device time with the PC running the client after
adding the device to the client.
8. Optional: Check Import to Group to create a group by the device name.
9. Click Add to add the device.
10. Optional: Perform the following operation(s).
Remote
Configuration

Click
on Operation column to set remote configuration of the
corresponding device.
Note
For detail operation steps for the remote configuration, see the user
manual of the device.

Device Status

Click
on Operation column to view device status, including
cameras, recording status, signal status, hardware status, etc.

Edit Device
Information

Click
on Operation column to edit the device information, such as
IP address, user name, and password.

Check Online User

Click
on Operation column to check the online users who access
the device, such as user name, user type, user's IP address, and login
time.

Refresh

Click

Delete Device

Select one or multiple devices and click Delete to delete the selected
device(s) from the client.

on Operation column to get the latest device information.
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Add Multiple Online Devices
You can add multiple online devices to the client in a batch.
Before You Start
Make sure the to‐be‐added devices are online.
Steps
1. Enter the Device Management module.
2. Click Device tab on the top of the right panel.
3. Click Online Device to show the online device area at the bottom of the page.
The searched online devices are displayed in the list.
4. Select multiple devices.
Note
For the inactive device, you need to create the password for it before you can add the device
properly. For detailed steps, refer to Activate Devices.
5. Click Add to open the device adding window.
6. Enter the required information.
User Name
By default, the user name is admin.
Password
Enter the device password.
Caution
The password strength of the device can be automatically checked. We highly recommend
you change the password of your own choosing (using a minimum of 8 characters, including
at least three kinds of following categories: upper case letters, lower case letters, numbers,
and special characters) in order to increase the security of your product. And we recommend
you reset your password regularly, especially in the high security system, resetting the
password monthly or weekly can better protect your product.
Proper configuration of all passwords and other security settings is the responsibility of the
installer and/or end‐user.
7. Check Synchronize Time to synchronize the device time with the PC running the client after
adding the device to the client.
8. Optional: Check Import to Group to create a group by the device name.
9. Click Add to add the devices.
10. Optional: Perform the following operation(s).
Remote
Configuration

Click
on Operation column to set remote configuration of the
corresponding device.
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Note
For detail operation steps for the remote configuration, see the user
manual of the device.

Device Status

Click
on Operation column to view device status, including
cameras, recording status, signal status, hardware status, etc.

Edit Device
Information

Click
on Operation column to edit the device information, such as
IP address, user name, and password.

Check Online User

Click
on Operation column to check the online users who access
the device, such as user name, user type, user's IP address, and login
time.

Refresh

Click

Delete Device

Select one or multiple devices and click Delete to delete the selected
device(s) from the client.

on Operation column to get the latest device information.

2.2.2 Add Device by IP Address or Domain Name
When you know the IP address or domain name of the device to add, you can add devices to the
client by specifying the IP address (or domain name), user name, password, etc.
Steps
1. Enter Device Management module.
2. Click Device tab on the top of the right panel.
The added devices are displayed on the right panel.
3. Click Add to open the Add window, and then select IP/Domain as the adding mode.
4. Enter the required information.
Name
Create a descriptive name for the device. For example, you can use a nickname that can show
the location or feature of the device.
Address
The IP address or domain name of the device.
Port
The devices to add share the same port number. The default value is 8000.
User Name
Enter the device user name. By default, the user name is admin.

6

Mira
Password
Enter the device password.
Caution
The password strength of the device can be automatically checked. We highly recommend
you change the password of your own choosing (using a minimum of 8 characters, including
at least three kinds of following categories: upper case letters, lower case letters, numbers,
and special characters) in order to increase the security of your product. And we recommend
you reset your password regularly, especially in the high security system, resetting the
password monthly or weekly can better protect your product.
Proper configuration of all passwords and other security settings is the responsibility of the
installer and/or end‐user.
5. Optional: Add the offline devices.
1) Check Add Offline Device.
2) Enter the required information, including the device channel number and alarm input
number.
Note
When the offline device comes online, the software will connect it automatically.
6. Optional: Check Transmission Encryption (TLS) to enable transmission encryption using TLS
(Transport Layer Security) protocol for security purpose .
Note
● This function should be supported by the device.
● If you have enabled Certificate Verification, you should click Open Certificate Folder to open
the default folder, and copy the certificate file exported from the device to this default
directory to strengthen the security. See Certificate Verification for Transmission Encryption
for details about enabling certificate verification.
● You can log into the device to get the certificate file by web browser.
7. Check Synchronize Time to synchronize the device time with the PC running the client after
adding the device to the client.
8. Optional: Check Import to Group to create a group by the device name.
9. Finish adding the device.
– Click Add to add the device and back to the device list page.
– Click Add and New to save the settings and continue to add other device.
10. Optional: Perform the following operation(s).
Remote
Configuration

Click
on Operation column to set remote configuration of the
corresponding device.
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Note
For detail operation steps for the remote configuration, see the user
manual of the device.

Device Status

Click
on Operation column to view device status, including
cameras, recording status, signal status, hardware status, etc.

Edit Device
Information

Click
on Operation column to edit the device information, such as
IP address, user name, and password.

Check Online User

Click
on Operation column to check the online users who access
the device, such as user name, user type, user's IP address, and login
time.

Refresh

Click

Delete Device

Select one or multiple devices and click Delete to delete the selected
device(s) from the client.

on Operation column to get the latest device information.

2.2.3 Add Devices by IP Segment
If the devices share the same port No., user name and password, and their IP addresses are
sharing an IP segment. You can specify the start IP address and the end IP address, port No., user
name, password, etc of the devices to add them to the client.
Steps
1. Enter the Device Management module.
2. Click Device tab on the top of the right panel.
The added devices are displayed on the right panel.
3. Click Add to open the Add window.
4. Select IP Segment as the adding mode.
5. Enter the required information.
Start IP
Enter a start IP address.
End IP
Enter an end IP address in the same network segment with the start IP.
Port
Enter the device port No. The default value is 8000.
User Name
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By default, the user name is admin.
Password
Enter the device password.
Caution
The password strength of the device can be automatically checked. We highly recommend
you change the password of your own choosing (using a minimum of 8 characters, including
at least three kinds of following categories: upper case letters, lower case letters, numbers,
and special characters) in order to increase the security of your product. And we recommend
you reset your password regularly, especially in the high security system, resetting the
password monthly or weekly can better protect your product.
Proper configuration of all passwords and other security settings is the responsibility of the
installer and/or end‐user.
6. Optional: Add the offline devices.
1) Check Add Offline Device.
2) Enter the required information, including the device channel number and alarm input
number.
Note
When the offline device comes online, the software will connect it automatically.
7. Optional: Check Transmission Encryption (TLS) to enable transmission encryption using TLS
(Transport Layer Security) protocol for security purpose .
Note
● This function should be supported by the device.
● If you have enabled Certificate Verification, you should click Open Certificate Folder to open
the default folder, and copy the certificate file exported from the device to this default
directory to strengthen the security. See Certificate Verification for Transmission Encryption
for details about enabling certificate verification.
● You can log into the device to get the certificate file by web browser.
8. Check Synchronize Time to synchronize the device time with the PC running the client after
adding the device to the client.
9. Optional: Check Import to Group to create a group by the device name.
10. Finish adding the device.
– Click Add to add the device and back to the device list page.
– Click Add and New to save the settings and continue to add other device.
11. Optional: Perform the following operation(s).
Remote
Configuration

Click
on Operation column to set remote configuration of the
corresponding device.
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Note
For detail operation steps for the remote configuration, see the user
manual of the device.

Device Status

Click
on Operation column to view device status, including
cameras, recording status, signal status, hardware status, etc.

Edit Device
Information

Click
on Operation column to edit the device information, such as
IP address, user name, and password.

Check Online User

Click
on Operation column to check the online users who access
the device, such as user name, user type, user's IP address, and login
time.

Refresh

Click

Delete Device

Select one or multiple devices and click Delete to delete the selected
device(s) from the client.

Remote
Configuration

Click
on Operation column to set remote configuration of the
corresponding device.

on Operation column to get the latest device information.

Note
For detail operation steps for the remote configuration, see the user
manual of the device.

Edit Device
Information

Click

to edit the device details.

Delete Device

Select one or multiple devices and click Delete to delete the selected
device(s) from the client.
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2.3 Edit Device's Network Information
After activating device, you can edit the network information (including IP address, port number,
gateway, etc.) for the online device.
Before You Start
Activate the device if the device status is inactivated.
Steps
1. Enter Device Management page.
2. Click Device tab on the top of the right panel.
3. Click Online Device to show the online device area.
All the online devices sharing the same subnet will be displayed in the list.
4. Select an activated device in Online Device area.
5. Click
on the Operation column to open the Modify Network Parameter window.
Note
This function is only available on the Online Device area.
6. Optional: Change the device IP address to the same subnet with your computer if you need to
add the device to the client.
– Edit the IP address manually.
– Check DHCP to set the IP address as a static IP address.
7. Enter the password created when you activate the device.
Caution
The password strength of the device can be automatically checked. We highly recommend you
change the password of your own choosing (using a minimum of 8 characters, including at least
three kinds of following categories: upper case letters, lower case letters, numbers, and special
characters) in order to increase the security of your product. And we recommend you reset your
password regularly, especially in the high security system, resetting the password monthly or
weekly can better protect your product.
Proper configuration of all passwords and other security settings is the responsibility of the
installer and/or end‐user.
8. Click OK to complete the network settings.
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2.4 Restore/Reset Device Password
If you forgot the password of the detected online devices, you can restore the device's default
password or reset the device's password through the client.

2.4.1 Reset Device Password
If you forgot the password of the detected online devices, you can reset the device password via
the client.
Steps
1. Enter Device Management page.
2. Click Device tab on the top of the left panel.
3. Click Online Device to show the online device area.
All the online devices sharing the same subnet will be displayed in the list.
4. Select the device from the list and click
on the Operation column.
5. Reset the device password.
– Click Export to save the device file on your PC and then send the file to our technical support.
Note
For the following operations for resetting the password, contact our technical support.
– Click Generate to pop up the QR Code window and click Download to save the QR code to
your PC. You can also take a photo of the QR code to save it to your phone. Send the picture
to our technical support.
Note
For the following operations for resetting the password, contact our technical support.
– Select the Safe Mode according to actual needs.
Note
For the following operations for resetting the password, contact our technical support.
Caution
The password strength of the device can be automatically checked. We highly recommend you
change the password of your own choosing (using a minimum of 8 characters, including at least
three kinds of following categories: upper case letters, lower case letters, numbers, and special
characters) in order to increase the security of your product. And we recommend you reset your
password regularly, especially in the high security system, resetting the password monthly or
weekly can better protect your product.
Proper configuration of all passwords and other security settings is the responsibility of the
installer and/or end‐user.
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2.4.2 Restore Device's Default Password
If you forget the password of the detected online devices, you can restore their default password
via the client.
Steps
1. Enter Device Management page.
2. Click Device tab on the top of the left panel.
3. Click Online Device to show the online device area.
All the online devices sharing the same subnet will be displayed in the list.
4. Select a device and click
on the Operation column to open the Reset Password window.
5. Restore the device password.
– Enter the security code, and then you can restore the default password of the selected
device.
Note
For getting the security code, contact our technical support.
– Click Export to save the device file on your PC and send the file to our technical support.
Note
For the following operations for resetting the password, contact our technical support.
What to do next
The default password (12345) for the admin account is for first‐time login purposes only. You must
change this default password to better protect against security risks, such as the unauthorized
access by others to the product that may prevent the product from functioning properly and/or
lead to other undesirable consequences.
Caution
The password strength of the device can be automatically checked. We highly recommend you
change the password of your own choosing (using a minimum of 8 characters, including at least
three kinds of following categories: upper case letters, lower case letters, numbers, and special
characters) in order to increase the security of your product. And we recommend you reset your
password regularly, especially in the high security system, resetting the password monthly or
weekly can better protect your product.
Proper configuration of all passwords and other security settings is the responsibility of the
installer and/or end‐user.
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2.5 Upgrade Device Firmware Version
When there is a new firmware version available for the added device, you can upgrade its
firmware version via the client.
Note
● The device should support this function.
● You can configure upgrading mode in System Configuration. See Set General Parameters for
details.
Enter the Device Management module, and then click Device tab to show the device list.
Perform the following operations according to different upgrading modes.

Disable
On the Device for Management panel, if there is a new firmware version available, the status in
the Firmware Upgrade column of the device will turn to Upgradeable.
Select the upgradeable device and click Upgrade to start upgrading the device firmware.
Note
The upgrade progress will show. When the upgrade is completed, the status in the Firmware
Upgrade column of the device will turn to Upgraded.

Prompt Me If Download and Upgrade
If there is a new firmware version available, a prompt window will pop up. Click Upgrade All to
start downloading and upgrading.

Download and Prompt Me If Upgrade
A dialog will pop up for selecting whether to upgrade after downloading package of new version.
Click Upgrade All to start upgrading the device firmware.
Note
After clicking Upgrade All, a prompt will pop up for viewing details. If you are not in Device
Management page, click View Details to jump to Device Management page; if you are in Device
Management page, close the prompt.

Download and Update Automatically
After the client detects the new version of the devices, it will download the new version and
upgrade the new version without noticing the user.
On the device management page, the following updating status will be shown in the Firmware
Update column.
No Available Version
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No new firmware version available.
Upgradeable
A new firmware version available.
Note
Move the cursor on
firmware version.

to view the current version, latest version, and upgrade content of the

Waiting
The device is waiting for upgrade.
Downloading
The client is downloading the package of the new firmware version.
Upgrading
The upgrading of the device firmware is going on.
Upgraded
Hover the cursor on Upgraded to show the version after upgrading.
Upgrading Failed
When the upgrade fails, a prompt will pop up for viewing details. If you are not in Device
Management page, click View Details to jump to Device Management page; if you are in Device
Management page, close the prompt. Hover the cursor on Upgrading Failed to show the error
details, and click Upgrade Again to try again.
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Chapter 3 Group Management
The resources added should be organized into groups for convenient management, including
encoding channels and alarm inputs. You can get the live view, play back the video files, and do
some other operations of the device through the group.

3.1 Add Group
You can add group to organize the added device for convenient management.
Steps
1. Enter the Device Management module.
2. Click Device Management → Group to enter the group management page.
3. Create a group.
– Click Add Group and enter a group name as you want.
– Click Create Group by Device Name and select an added device to create a new group by the
name of the selected device.
Note
The encoding channels and alarm inputs of this device will be imported to the group by
default.

3.2 Import Resources to Group
You can import the device resources (such as encoding channels and alarm input) to the added
group in a batch.
Before You Start
Add a group for managing devices. Refer to Add Group.
Steps
Note
Up to 256 encoding channels can be added to one group.
1. Enter the Device Management module.
2. Click Device Management → Group to enter the group management page.
3. Select a group from the group list and select the resource type as Encoding Channel or Alarm
Input.
4. Click Import.
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5. Select the thumbnails/names of the encoding channels or alarm inputs in the thumbnail/list
view.
Note
You can click

or

to switch the camera display mode to thumbnail view or to list view.

6. Click Import to import the selected resources to the group.

3.3 Edit Resource Parameters
After importing the resources to the group, you can edit the resource parameters. For encoding
channel, you can edit the channel name, stream type, protocol type, etc. For alarm input, you can
edit the resource name. Here we take encoding channel as an example.
Before You Start
Import the resources to group. Refer to Import Resources to Group.
Steps
1. Enter the Device Management module.
2. Click Device Management → Group to enter the group management page.
All the added groups are displayed on the left.
3. Select a group on the group list and click Encoding Channel.
The encoding channels imported to the group will display.
4. Click
in the Operation column to open the Edit Camera window.
5. Edit the camera information, including the camera name, the stream type, etc.
Video Stream
Select the stream type for live view of the camera as desired.
Note
You should start live view again to take effect.
Playback Stream Type
Select the stream type for playback of the camera as desired.
Note
● This field will display if the device supports dual‐stream.
● You should start live view again to take effect.
Rotation Type
Select the rotate type for the live view or playback of the camera as desired.
Protocol Type
Select the transmission protocol for the camera.
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Note
You should start live view again to take effect.
Streaming Protocol
Select the protocol as RTSP or private for getting stream when live view.
Note
You should start live view again to take effect.
Stream Media Server
Get stream of the camera via stream media server. You can select and manage the available
stream media server.
Copy to…
Copy the configured parameters to other camera(s).
Refresh
Get a new captured picture for the live view of the camera.
6. Click OK to save the new settings.

3.4 Remove Resources from Group
You can remove the added resources from the group.
Steps
1. Enter the Device Management module.
2. Click Device Management → Group to enter the group management page.
All the added groups are displayed on the left.
3. Click a group to show the resources added to this group.
4. Select the resource(s) and click Delete to remove the resource(s) from the group.
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Chapter 4 Cloud Account
The client software also supports to register a Cloud account, log into your Cloud account (created
from the Mira app) and manage the devices which support the Cloud service.

4.1 Register a Cloud Account
The client supports registering a Cloud account to manage devices which supports Cloud service.
Steps
1. Enter the login page of Cloud P2P.
– Click Log in in the upper‐right corner of the client.
1. Click Device Management → Device to enter the Device Management page.
2. Click Add to open the Add Device panel.
3. Select Cloud P2P as the adding mode.
4. Click Login.
The Login window pops up.
2. Click Register to open the Register Account window.
3. Enter the required information, including user name, password, confirm password, and phone
number/email address.
Caution
The password strength of the device can be automatically checked. We highly recommend you
change the password of your own choosing (using a minimum of 8 characters, including at least
three kinds of following categories: upper case letters, lower case letters, numbers, and special
characters) in order to increase the security of your product. And we recommend you reset your
password regularly, especially in the high security system, resetting the password monthly or
weekly can better protect your product.
Proper configuration of all passwords and other security settings is the responsibility of the
installer and/or end‐user.
4. Click Send Message to get a verification code.
The system will send verification code to your phone or email.
5. Enter the received verification code in the Verification Code text field.
6. Check I have read and agreed Terms of Service Privacy Policy.
7. Click Register to finish the registration.
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4.2 Log into Cloud Account
You can log into Cloud account via the client, so as to operate devices managed by Cloud account.
Before You Start
Register a Cloud P2P account.
Note
For details, refer to Register a Cloud P2P Account.
Steps
1. Enter the login page of Cloud P2P.
– Click Log in in the upper‐right corner of the client.
1. Click Device Management → Device to enter the Device Management page.
2. Click Add to open the Add Device panel.
3. Select Cloud P2P as the adding mode.
4. Click Login.
The Login window pops up.
2. Enter user name/phone number, and password.
3. Click Log in to log into your account.
Log in will turn to Logged in.
4. Optional: Click Logged in → Log out to log out of your account.
Note
● Devices added by Cloud P2P will be hidden after logging out the Cloud P2P.
● Alarm‐related pictures saved in Cloud P2P will be valid for 2 hours.
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Chapter 5 Live View
For the surveillance task, you can view the live video of the added network cameras and video
encoders on the Main View page. And some basic operations are supported, including picture
capturing, manual recording, window division, PTZ control, etc.

5.1 Start Live View
You can start the live view of one camera or all cameras in a group. You can also start the live view
in custom view mode.

5.1.1 Start Live View
You can start the live view of only one camera.
Before You Start
A camera group is required to be defined for live view.
Steps
1. Open the Main View page.
2. Optional: Click
in live view toolbar to select a window division mode for live view.
3. Optional: Click
in the live view toolbar to set the parameters such as view scale, play
performance, picture saving path, etc.
Note
You can also set the parameters in System Configuration. For details, refer to System
Configuration.
4. Do one of the following operations to start the live view of one camera.
– Drag a camera in the group from camera list to a display window to start the live view.
– Double‐click the camera name after selecting a display window to start the live view.
– Move the cursor to the camera name and click
near the camera name to start live view
after selecting a display window.
Note
If the device supports stream encryption, and the stream of its live view is encrypted, you are
required to enter a stream key for double verification.
The live video of the camera will start playing in the selected window. The next window will be
selected automatically.
5. Optional: Drag the video of the camera in live view to another window to change the display
window for live view.
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6. Optional: Move the cursor to the camera name and click
name to switch the stream type according to actual needs.

→ Stream near the camera

Note
You can click All Stream Types to select the frequently used stream types to display on the
right‐click menu.

5.1.2 Start Live View for Camera Group
You can start the live view for all cameras in one group synchronously.
Before You Start
A camera group is required to be defined for live view.
Steps
1. Open the Main View page.
2. Optional: Click
in the live view toolbar to set the parameters such as view scale, play
performance, picture saving path, etc.
Note
You can also set the parameters in System Configuration. For details, refer to System
Configuration.
3. Perform one of the following operations to start the live view of all cameras in a group.
– Drag a camera group from camera list to the display window to start the live view.
– Double‐click the group name to start the live view.
– Move the cursor to the group name and click
near the group name to start live view for
all the cameras in the group.
Note
● The display window number is self‐adaptive to the number of cameras in the group.
● If the device supports stream encryption, and the stream of its live view is encrypted, you are
required to enter a stream key for double verification.
4. Optional: Move the cursor to the group name and click
→ Stream near the group name to
switch the stream type for the cameras in the group according to actual needs.
Note
Before switching to the sixth, seventh, eighth, ninth, and tenth stream, you should set these
stream type in the device's web configuration page. For details, refer to the user manual of the
device.
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5.1.3 Add Custom View
A view is a window division with cameras configured to each window; View mode enables you to
save the window division and the correspondence between cameras and windows as favorite to
quickly access the related cameras later. For example, you can link camera 1, camera 2, and
camera 3 located in your office to display windows and save them as a view called office. Besides
the pre‐defined default views, you can customize views for further operations.
Steps
1. Open the Main View page.
2. Move the cursor to the Custom View in the View panel and click
to create a new view.
3. Enter a name for the view.
4. Optional: Click
in the live view toolbar to set window division mode for the new view.
Note
By default, the new view is in 4‐window division.
5. Start live view for specified camera in specified window according to actual needs.
6. Click
to directly save the view.
7. Optional: Perform the following operations after adding the custom view.
Edit View Name

Move the cursor over the new view and click
name.

to edit the view

Delete View

Move the cursor over the new view and click

to delete the view.

5.1.4 Start Live View in Custom View Mode
After adding a custom view, you can start live view for the cameras in the custom view.
Before You Start
Customize a view which containing information such as window division, camera and
correspondence between cameras and windows. See Add Custom View for details.
Steps
1. Open the Main View page.
2. Optional: Click
in the live view toolbar to set the parameters such as view scale, play
performance, picture saving path, etc.
Note
You can also set the parameters in System Configuration. For details, refer to System
Configuration.
3. Click

to expand the custom view list in the View panel.
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4. Click a custom view to start live view.
The video of the added cameras in the selected view displays.
5. Optional: Perform the following operation(s) after starting live view in custom view mode.
Start Instant
Playback

Move the cursor over the new view and click
to start instant
playback for the cameras in the view. See Instant Playback for
details.

Start Auto‐Switch of
All Custom Views

Move the cursor over Custom View and click
to start switching all
views in the custom view list automatically. See details in Auto‐Switch
in Live View.

5.2 Auto‐Switch in Live View
You can display live view of cameras or display the custom views in turn, which is called "auto‐
switch".
When auto‐switching in live view, three modes are available:
● Auto‐Switch All Cameras in Default View
● Auto‐Switch Cameras in a Group
● Auto‐Switch Custom Views

5.2.1 Auto‐Switch All Cameras
The video of all the cameras in the camera list can switch automatically in a self‐adaptive mode. If
you start auto‐switch of all cameras, the live view of all cameras can be displayed quickly, which is
an effective way for live view. The auto‐switch is performed with an interval which can be
configured. You can also switch to playback and perform other operations on the auto‐switch
window.
Steps
1. Open the Main View page.
2. Click Auto‐Switch → Multi‐Window Auto‐Switch on the left panel.
3. Hover the cursor on Auto‐Switch All Cameras, and then click
.
All cameras in the camera list start auto‐switching in a self‐adaptive mode.
4. Optional: Click 20 Seconds at the bottom of the page to change the auto‐switch interval.
Example
If you set the interval as 10 seconds, the image of each camera will be displayed for 10 seconds
and then switch to next camera.

5.2.2 Auto‐Switch Cameras in a Group
The video stream of the cameras from the same group can switch automatically in a selected
display window. For example, if you start auto‐switch of a group containing 5 cameras, the live
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view of the 5 cameras will be displayed in turn with an interval which can be configured. You can
also switch to playback and perform other operations on the display window.
Steps
1. Open the Main View page.
2. Click Auto‐Switch → Single Window Auto‐Switch on the left panel to show the groups.
3. Select a display window on the right panel.
4. Hover the cursor on a group name and click
.
The cameras in the selected group starts auto‐switch in the display window.
Note
The audio is off by default after auto‐switch starts.
5. Optional: Click 20 Seconds at the bottom of the page to change the auto‐switch interval.
Example
If you set the interval as 10 seconds, the image of each camera will be displayed for 10 seconds
and then switch to next camera.

5.2.3 Auto‐Switch Custom Views
A view is a window division with resource channels (e.g., cameras and access points) linked to each
window. View mode enables you to save the window division and the correspondence between
cameras and windows as favorite so that you can quickly access these channels later. If you saved
a view containing all cameras on a floor beforehand, you can view the live view of all the cameras
on the floor in turn by a one‐stop operation. In this way, you do not have to search these cameras
in the camera list every time you login. The auto‐switch performs with an interval which can be
configured manually.
Before You Start
Add the custom views. See Add Custom View for details.
Steps
1. Open the Main View page.
2. Click Resource → Multi‐Window Auto‐Switch on the left panel.
3. Hover the cursor on Auto‐Switch All Views and click
.
All custom views starts auto‐switching.
4. Optional: Click 20 Seconds at the bottom of the page to change the auto‐switch interval.
Example
If you set the interval as 10 seconds, the image of each camera will be displayed for 10 seconds
and then switch to next camera.
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5.3 PTZ Control
The software provides PTZ control for cameras with pan/tilt/zoom functionality. During the PTZ
control, you can set preset, patrol, and pattern, and you can also open a new window for
controlling the PTZ.
Note
Cloud P2P device only supports the PTZ movements to the directions of up, down, left, and right.
Enter the Main View module, and select PTZ Control to open the PTZ control panel.
The following icons are available on the PTZ control panel.
Table 6‐1 Icons on the PTZ Control Panel
Icon

Name

Description
Click or hold the left mouse button to turn
the PTZ around.

Direction Buttons

Click to turn around the PTZ horizontally and
continuously; click again to stop turning.

Speed Control

Drag the slider to adjust the PTZ moving
speed.

Zoom in/out

Zoom in to view close image for details;
zoom out to view a panoramic image.

Focus +/‐

Click Focus + move the focal point forward,
and click Focus ‐ to move the focal point
backward.

Iris +/‐

Used for adjusting the luminance of the
image. The larger the iris is, the more the
light enters, and the brighter the image will
be.

3D Positioning

Use the left key of mouse to click on the
desired position in the video image and drag
a rectangle area in the lower right direction,
then the dome system will move the position
to the center and allow the rectangle area to
zoom in. Use the left key of mouse to drag a
rectangle area in the upper left direction to
move the position to the center and allow
the rectangle area to zoom out.

Auxiliary Focus

Click to focus automatically.

Lens Initialization

Initialize the lens and focus again for a clear
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Icon

Name

Description
image.
Click to fill light.

Light

Note
This function needs to be supported by the
device.

Wiper

Use the wiper to clear the dust on the
camera lens.

Manual Tracking

For speed dome with auto‐tracking function,
enable the auto‐tracking (via right‐click
menu) for it and click the icon to manually
track the target by clicking on the video.

Menu

For analog speed dome, click the icon to
display its local menu. For detailed operation
of the menu, refer to user manual of the
speed dome.

One‐Touch Patrol

For speed dome with one‐touch patrol
function, click the icon and the speed dome
starts patrol from the predefined preset
No.1 to preset No.32 in order after a period
of inactivity (park time). For setting the park
time, refer to user manual of the speed
dome.

One‐Touch Park

For the speed dome with one‐touch park
function, click the icon and the speed dome
saves the current view to the preset No.32.
The device starts to park at preset No. 32
automatically after a period of inactivity
(park time). For setting the park time, refer
to user manual of the speed dome.

Enable Manual De‐Icing
Heater

Enable this function to ensure the camera
performance in environment under 0℃.

Manual Face Capture

Click this button, and hod the left mouse
button to select a face in the image to
capture it. The picture will be uploaded to
the server for viewing.
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Icon

Name

Description

Synchronize FOV

For thermal cameras. Click to synchronize
the optical channel's field of view with that
of the thermal channel.

Regional Exposure

For speed domes, click the icon and draw a
rectangle on the image to optimize the
exposure effect in this region.

Regional Focus

For speed domes, click the icon and draw a
rectangle on the image to optimize the focus
effect in this region.

5.3.1 Configure Preset
A preset is a predefined image position which contains information of pan, tilt, focus and other
parameters. After setting preset, you can quickly locate the desired camera's position by calling
the preset.
Steps
1. Open the Main View page and start the live view of the PTZ camera.
2. Click PTZ Control on the left to expand the PTZ Control panel.
3. Unfold the PTZ control panel in the lower‐left corner of the page.
4. Select one PTZ window from the main view windows.
5. Optional: On the PTZ control panel, click the preset name (e.g. Preset 1) to edit the preset
name.
6. On the PTZ control panel, click the direction button and function button on the PTZ control
panel, to adjust the scene to the place you want to mark as a preset.
7. Click
to save the preset settings.
8. Optional: Perform the following operation(s) after setting the preset.
Call Preset

Select the preset and click
to call the preset. You can also press
the number key (e.g., 4) on keyboard to call the preset 1 to 9, and
press [, number keys (e.g., 124), and ] on keyboard to call the other
preset.

Edit Preset

Adjust the direction, position and view of the PTZ camera, and then
and click
to save the preset again. The old preset settings will be
replaced.

Delete Preset

Select the configured preset from the list and click
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5.3.2 Configure Patrol
A patrol is a scanning track specified by a group of user‐defined presets, with the scanning speed
between two presets and the dwell time at the preset separately programmable.
Before You Start
Add two or more presets for one PTZ camera.
Steps
Note
For Cloud P2P device, patrol is not supported.
1. Open the Main View page and start the live view of PTZ camera.
2. Click PTZ Control on the left to expand the PTZ Control panel.
3. Click
tab to enter the PTZ patrol configuration panel.
4. Select a path No. from the drop‐down list.
5. Click
to open Add Patrol No. dialog.
6. Select a preset from the drop‐down list and set the dwell time and patrol speed for the preset in
the dialog.
7. Click OK.
8. Repeat step 5, 6, and 7 to add other presets to the patrol.
9. Optional: Perform the following operation(s) after setting the patrol.
Call Patrol

Click

to call the patrol.

Stop Calling Patrol

Click

to stop calling the patrol.

Edit Preset in Patrol

Select a preset in the patrol path and click

to edit the preset.

Remove Preset from
Patrol

Select a preset in the patrol path and click
from the patrol.

to remove the preset

5.3.3 Configure Pattern
A pattern is a memorized, repeating series of pan, tilt, zoom, and preset functions.
Steps
Note
For Cloud P2P device, pattern is not supported.
1. Open the Main View page and start the live view of the PTZ camera.
2. Click PTZ Control on the left to expand the PTZ Control panel.
3. Click
tab to enter the PTZ pattern configuration panel.
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4. Click
to start the recording of this pattern path.
5. Use the direction buttons to control the PTZ movement.
6. Click
to stop recording and save the recorded pattern.
7. Optional: Perform the following operation(s) after setting the pattern.
Call Pattern

Click

to call the pattern.

Stop Calling Pattern

Click

to stop calling the pattern.

Delete Pattern

Select one pattern and click

Delete All Patterns

Click

to delete the pattern.

to delete all the patterns.

5.4 Customize Window Division
The client software provides multiple kinds of predefined window divisions. You can also set
custom the window division as desired.
Steps
Note
Up to 5 window divisions can be customized.
1. Open the Main View or Remote Playback page.
2. Click
on the live view or playback toolbar to open the window division panel.
3. Click Add to open the Add Custom Window Division dialog.
4. Enter the window numbers in both horizontal and vertical dimension in the Dimension field, and
then press Enter on your keyboard.
Note
For remote playback, up to 16 windows can be played at the same time, so the custom window
division with more than 16 windows is invalid.
5. Optional: Drag your mouse to select the adjacent windows, and click Joint to joint them as a
whole window.
6. Optional: Select the joint window and click Restore to cancel the joint.
7. Click Save.
8. Optional: Click or drag a division mode to the displaying window to apply the mode for
displaying.
9. Optional: Edit a customized window division mode.
1) Click
on the live view or playback toolbar to open the window division panel.
2) Click Edit to open the Add Custom Window Division.
3) Select a customized division mode and perform operations including renaming, setting
dimension, jointing/undo jointing windows.
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5.5 Manually Record and Capture
During live view, you can record videos and capture pictures manually, and then view the recorded
video files and captured pictures in the local PC.

5.5.1 Manually Record Video
Manual recording function allows to record the live video on the Main View page manually, and
you can store the video files in the local PC.
Steps
Note
Manual recording is not supported by Cloud P2P device during live view.
1. Open the Main View page.
2. Start the live view.
3. Perform one of the following operations to start manual recording.
– Move the cursor to the display window in live view to show the toolbar and click
on the
toolbar.
– Right‐click on the display window and click Start Recording on the right‐click menu.
The icon
turns to . An indicator
appears in the upper‐right corner of the display
window.
4. Click
to stop the manual recording.
The recorded video file is automatically saved to the local PC, and a small window with the
saving path information appears in the lower‐right corner of desktop.
Note
The saving path of the recorded video files can be set on the System Configuration page. See Set
File Saving Path for details.

5.5.2 View Local Videos
You can view the recorded video files stored in your local PC.
Before You Start
Record the live video.
Steps
1. Click
→ File → Open Video File in the upper‐right corner to open the Video Files page.
2. Select the camera to search the recorded video files from the Camera Group list.
3. Specify the start time and end time in the lower‐left corner for the searching.
4. Click Search.
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The video files recorded between the start time and end time displays in thumbnail format on
the page.
5. Optional: Perform the following operation(s) after the search.
Delete Video File

Select the video file, and click Delete to delete the video file.

Send Email

Select the video file, and click Email to send an email notification with
the selected video file attached.
Note
To send an email notification, the email settings need to be
configured before proceeding. For details, refer to Set Email
Parameters.

Save Local Video

Select the video file, and click Save as to save a new copy of the video
file.

Playback

Double‐click the video file to start the local playback.

5.5.3 Capture Pictures
You can capture pictures during the live view.
Perform this task when you need to capture pictures during the live view.
Steps
1. Open Main View page and start the live view of a camera.
2. Perform one of the following operations to capture pictures.
– Move the cursor to the display window in live view to show the toolbar and click
on the
toolbar.
– Right‐click the display window and click Capture on the right‐click menu.
The captured picture is automatically saved to the local PC, and a small window with the picture
preview and saving path information appears in the lower‐right corner of desktop.
Note
The saving path of the captured pictures can be set on the System Configuration page. For
details, refer to Set File Saving Path.

5.5.4 View Captured Pictures
The pictures captured in the live view are stored in the PC running the software. You can view the
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captured pictures if needed.
Before You Start
Capture pictures in the live view.
Steps
1. Click
→ File → Open Captured Picture in the upper‐right corner to open the Captured
Picture page.
2. Select the camera to search the captured pictures from the Camera Group list.
3. Specify the start time and end time in the lower‐left corner for the searching.
4. Click Search.
The pictures captured between the start time and end time display in thumbnail format on the
page.
5. Optional: Perform the following operation(s) after the search.
Enlarge Picture

Double‐click the picture thumbnail to enlarge it for a better view.

Print Picture

Select the captured picture, and click Print to print the selected
picture.

Delete Picture

Select the captured picture, and click Delete to delete the selected
picture.

Send Email

Select the captured picture, and click Email to send an email
notification with the selected picture attached.

Save Picture

Select the captured picture, and click Save as to save a new copy of
the selected picture.

5.6 Instant Playback
Instant playback shows a piece of the video which is remarkable, or which is unclear on the first
sight. So you can play the video files instantly on the Main View page and get an immediate review
if needed.
Before You Start
Record the video files and store them on the storage devices, such as the SD/SDHC cards and
HDDs on the DVRs, NVRs, network cameras, etc., or on the storage servers.
Steps
1. Open Main View page and start the live view.
2. Perform one of the following operations to show the pre‐play durations' list of instant playback.
– Move the cursor to the display window to show the toolbar and click
.
– Right‐click the display window and select Switch to Instant Playback on the right‐click menu.
– Move the cursor to default view or custom view node on the View panel and click
.
A list with pre‐play durations of 30s, 1 min, 3 min, 5 min, 8 min, and 10 min displays.
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3. Select a time period from the appeared list to start the instant playback.
Example
If you select 3 min, and the current time of the live view is 09:30:00, then the instant playback
will start from 09:27:00.
During the instant playback, an indicator
appears in the upper‐right corner of the display
window.
4. Optional: Click
again to stop the instant playback and go back for the live view.

5.7 Live View in Low Bandwidth
In situation of low network bandwidth, the speed of video streaming might be much slower due to
the bandwidth limit. To provide normal quality in less streaming speed for low bandwidth users,
the client provides live view in low bandwidth mode. Before that, you need to set the streaming
protocol and perform other operations first.
For details about the settings, refer to How to get better performance of live view and playback
when network bandwidth is low?.

5.8 More Functions
There are some more functions supported in the live view, including auxiliary screen preview,
digital zoom, channel‐zero, two‐way audio, camera status, and synchronization.

Auxiliary Screen Preview
Display the live video on different auxiliary screens for the convenient preview of multiple
monitoring scenes.
Note
Up to 3 auxiliary screens are supported.

Digital Zoom
Drag the mouse to draw a rectangle area in the lower‐right/upper‐left direction to zoom in or out
the drawn area. Or use the mouse wheel to zoom in or out the view in digital zoom mode.

Channel‐Zero
For the channel‐zero of the device, hold the Ctrl key and double‐click to display the specific
channel. Hold the Ctrl key and double‐click again to restore.

Two‐Way Audio
Two‐way audio function enables the voice talk of the camera. You can get not only the live video
but also the real‐time audio from the camera. If the device has multiple two‐way audio channels,
you can select a channel to start two‐way audio.

34

Mira
Note
● The two‐way audio can be used for only one camera at one time.
● Cloud P2P device doesn't support selecting channel during two‐way audio.

Camera Status
The camera status, such as recording status, signal status, connection number, etc., can be
detected and displayed for checking. The status information refreshes every 10 seconds.

Synchronization
The synchronization function provides a way to synchronize the device clock with the PC which
runs the client software.
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Chapter 6 Remote Storage Configuration
The video files and captured pictures can be stored on the HDDs, Net HDDs, or SD/SDHC cards on
the local device, or on the storage server connected.

6.1 Store Picture and Video on NVR, or Network Camera
Some local devices, including the NVRs, and Network Cameras, provide storage devices such as the
HDDs, Net HDDs and SD/SDHC cards for video and picture files. You can set a recording schedule
or capture schedule for the channels of the local devices.
Before You Start
Make sure the newly installed storage devices have be formatted. Refer to Format Storage
Server's HDD for details.
Perform this task when you need to store the picture and video files on the encoding device such
as DVR, NVR, or network camera.
Steps
Note
The pictures captured through the capture schedule are stored on the local device and can be
searched on the remote configuration page of the device.
1. Enter the Storage Schedule module.
2. Select the camera in the Camera Group list.
3. Set Recording Schedule switch or Capture Schedule switch to ON on Storage on Encoding
Device area to enable device local recording or capture.
4. Select the recording or capture schedule template from the drop‐down list.
All‐day Template
All‐day continuous recording.
Weekday Template
Working‐hours continuous recording from 8:00 AM to 8:00 PM.
Event Template
All‐day event triggered recording.
Template 01 to 08
Fixed templates for specific schedules. You can edit the templates if needed.
Custom
Customize a template as you want.
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Note
If you need to edit or customize the template, refer to Configure Recording Schedule
Template or Configure Capture Schedule Template.
5. Click Advanced of Recording Schedule to set the recording advanced parameters.
Note
The displayed items vary according to the devices.

Pre‐record
Normally used for the event triggered record, when you want to record before the event
happens.
Post‐record
After the event finished, the video can also be recorded for a certain time.
Keep Video Files for
The time for keeping the video files in the storage device, once exceeded, the files will be
deleted. The files will be saved permanently if the value is set as 0.
Redundant Recording
Save the video files not only in the R/W HDD but also in the redundant HDD.
Record Audio
Record the video files with audio or not.
Video Stream
Select the stream type for the recording.
Note
For specific type of devices, you can select Dual‐Stream for recording both main stream and
sub‐stream of the camera. In this mode, you can switch the stream type during remote
playback. Refer to Normal Playback for stream switch during playback.
6. Click Advanced of Capture Schedule to set the capture advanced parameters.
Resolution
Select the resolution for the continuous or event captured pictures.
Picture Quality
Set the quality for the continuous or event captured pictures.
Interval
Select the interval which refers to the time period between two capturing actions.
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Captured Picture Number
Set the picture number for event capture.
7. Optional: Click Copy to... to copy the recording schedule settings to other channels.
8. Click Save to save the settings.

6.2 Store Pictures on Local PC
You can store the pictures and the additional information, such as the heat map, people counting
data, and road traffic data, to the local PC.
Perform this task when you need to store pictures and additional information on local PC.
Steps
1. Enter Storage Schedule module.
2. Select the camera in the Camera Group list.
Note
This function should be supported by the device.
3. Select storage content.
Picture Storage
Store the alarm pictures of the camera when event occurs. You can click System
Configuration → File to modify the saving path of pictures.
Additional Information Storage
Store the additional information (e.g., heat map, people counting data, etc.) on local PC.
4. Click Save to save the settings.

6.3 Configure Recording Schedule Template
You can edit the recording schedule template, or customize a recording schedule template.
Steps
1. Enter the Storage Schedule module.
2. Open the template settings window.
Select Template 01 to Template 08 from the drop‐down list and click Edit.Select Custom from the
drop‐down list.
3. Drag on the time‐line to set the time periods for the selected template when the cursor turns to
.
Continuous
Normal and continuous recording. The schedule time bar is marked with
Event Recording
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The recording is triggered by event. The schedule time bar is marked with

.

Command
The recording triggered by command. The schedule time bar is marked with

.

Note
Command triggered recording is only available for the ATM transactions when the ATM DVR
is added to the client.
Note
Up to 8 time periods can be set for each day in the recording schedule.
4. Optional: After setting the time periods, you can do one or more of the following:
Move

Drag a time period to move it when the cursors turns to

.

Lengthen or Shorten

Select a time period and then lengthen or shorten it when the cursor
turns to
.

Set Accurate Time

Click a time period to set the accurate start time and end time of the
period.

Delete

Select the configured schedule time period and click

Delete All

Click

Copy to

Select one date and click
to the other dates.

to delete it.

to delete all the configured time periods.
to copy the date's time period settings

5. Optional: For template 01 to 08, you can edit the template name as you want.
6. Click OK to save the settings.
Note
If you select Custom to customize a template, you can click Save as Schedule Template, and
then the custom template can be saved as template 01 to 08.

6.4 Configure Capture Schedule Template
You can edit the capture schedule template, or customize a capture schedule template.
Steps
1. Enter the Storage Schedule module.
2. Open the template settings window.
Select Template 01 to Template 08 from the drop‐down list and click Edit.Select Custom from the
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drop‐down list.
3. Drag on the time‐line to set time periods for the selected template when the cursor turns to
.
Continuous Capture
Normal and continuous capture. The schedule time bar is marked with

.

Event Capture
The capture is triggered by event. The schedule time bar is marked with
.
4. Optional: After setting the time period, you can do one or more of the followings
Move

When the cursor turns to
, you can move the time period you just
edited. You can also edit the displayed time point to set the accurate
time period.

Lengthen or Shorten

When the cursor turns to
selected time period.

Delete

Select a time period and click

Delete All

Click

Copy to

Select one date and click
to the other dates.

, you can lengthen or shorten the
to delete it.

to delete all the configured time periods.
to copy the date's time period settings

5. Optional: For template 01 to 08, you can edit the template name as you want.
6. Click OK to save the settings.
Note
If you select Custom to customize a template, you can click Save as Schedule Template, and
then the custom template can be saved as template 01 to 08.
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Chapter 7 Remote Playback
You can search the video files stored in the local device or the storage server by camera or
triggering event, and then play them remotely.
Note
You can set to play back the video files stored in the local device, in the storage server, or both in
the storage server and local device. For details, refer to Set Live View and Playback Parameters.

7.1 Normal Playback
You can search video files by camera or group for normal playback and download found video files
to local PC. You can also add a tag to mark important video footage, and so on.
You can right‐click the playback window to select the required operations from the shortcut menu.
Some are listed as follows:
Name

Description
Show/Hide Temperature Information

Show/Hide Temperature
Information

Note
The temperature information overlay is only supported by
thermal camera.

Tag Control

Add default (the default tag name is TAG) or custom tag (the
tag name is customized) for the video file to mark the
important video point. You can also edit the tag or go to the tag
position conveniently.

Other Capture Modes

● Print Captured Picture: Capture a picture and print it.
● Send Email: Capture the current picture and then send an
Email notification to one or more receivers. The captured
picture can be attached.
● Custom Capture: Capture the current picture. You can edit
its name and then save it.

Note
● The Cloud P2P device only supports normal playback and it also does not support the functions
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of reverse playback, slow forward or fast forward, and adding tag.
● For NVR which is added to the client by device's other user name (except admin), if Double
Verification is enabled on this NVR, when playing back videos on the client, you are required to
enter the user name and password created for double verification. For details about double
verification, refer to the user manual of the NVR.

7.1.1 Search Video Files
You can search the video files by date, and you can also enter keyword to filter the matched
results for normal playback.
Steps
1. Enter the Remote Playback module.
2. Click
on the left to enter the Event Playback page.
3. Optional: Click
to set the start date and end date of searching time period.
Note
In the calendar, the date which has video files recorded by schedule will be marked with
and the date which has video files recorded based on event will be marked with
.

,

4. Start the playback of camera (s) to search the video files of the selected camera (s). You can do
one of the followings to start the playback.
Note
Up to 16 cameras can be searched simultaneously.
– Drag the camera or group to a display window.
– Select a display window and double‐click the camera or group to start playback in the
selected window.
– Double‐click the cameras in turn to select the display window automatically and start
playback in the windows.

7.1.2 Play Video Files
After searching the video files for the normal playback, you can play the video via time line.
Steps
1. Enter the Remote Playback module.
2. Search the video files.
3. Play video via time line.
The video files will play automatically. You can click on the time line to position the desired
video segment of specified time for normal playback.
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Note
● The time line indicates the time duration for the video files, and the video files of different
types are color coded.
● You can use mouse wheel or click
/
to scale up or scale down the time line bar.
4. Optional: Perform the following operations on the toolbar to control the playback.
Single Frame
(Reverse)

Click
or scroll down the mouse wheel to play the video files frame
by frame (reversely).

Audio Control

Click
or
to turn off/on the sound. You can also adjust the
volume when turning on.

Download for
Multiple Cameras

Click
time.

to download video files of multiple cameras at the same

Note
For more details, refer to Download for Multiple Cameras.

Download Video
Files by Date

Click
to download the video files of the camera by date and store
them to local PC.

Accurate Positioning

Click

to set the accurate time point to play the video file.

7.2 Alarm Input Playback
When the alarm input is triggered and the linked video can be searched for alarm input playback.
This function requires the support of the connected device.
For the description of the alarm input playback toolbar and right‐click menu of display window,
refer to Normal Playback.
Note
Some icons may be not available for alarm input playback.

7.2.1 Search Video Files
You can search the video files by date, and you can also enter keyword to filter the matched
results for alarm input playback.
Steps
1. Enter the Remote Playback module.
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2. Click
on the left to enter the Event Playback page.
3. Select an alarm input channel at the left.
4. Optional: Click
to set the start date and end date of searching time period.
5. Select Alarm Input from the drop‐down list as the event type.
6. Click Search to start the search.
The matched video files of the selected alarm input will display on the right page in
chronological order. And by default, the first video file will play automatically.
7. Optional: Enter keyword in the Search field to filter the results.

7.2.2 Play Video Files
After searching the video files for the alarm input playback, you can play the video via file list or
timeline.
Steps
1. Enter the Remote Playback module.
2. Click
on the left to enter the Event Playback page.
3. Search the video files of the alarm input.
Note
See Search Video Files for details about searching video files of the alarm input.
4. Play video via file list or timeline.
– Double‐click the video file to play the video in the playback display window.
– Click on the timeline to positioning the desired video segment of specified time for alarm
input playback.
Note
● The timeline indicates the time duration for the video files, and the video files of different
types are color coded.
● You can use mouse wheel or click
/
to scale up or scale down the timeline bar.

7.3 Event Playback
The recorded video files triggered by event, such as motion detection, VCA detection, or behavior
analysis, can be searched for event playback. This function requires the support of the connected
device.
For the description of the event playback toolbar and right‐click menu of display window, refer to
Normal Playback.
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Note
Some icons may be not available for event playback.

7.3.1 Search Video Files
You can search the video files by date and by event type. And you can also enter keyword to filter
the matched results for event playback.
Steps
1. Enter the Remote Playback module.
2. Click
on the left to enter the Event Playback page.
3. Select the camera at the left.
4. Optional: Click
to set the start date and end date of searching time period.
Note
In the calendar, the date which has video files recorded by schedule will be marked with
and the date which has video files recorded based on event will be marked with
.

,

5. Select an event type from the drop‐down list.
6. Click Search to start the search.
The matched video files will display on the right page in chronological order. And by default, the
first video file will play automatically.
7. Optional: Enter keyword in the Search field to filter the results.

7.3.2 Play Video Files
After searching the video files for the event playback, you can play the video via file list or
timeline.
Steps
1. Enter the Remote Playback module.
2. Click
on the left to enter the Event Playback page.
3. Search the video files recorded based on event.
4. Play the video file.
– Double‐click the video file to play the video in the playback display window.
– Click on the timeline to positioning the desired video segment of specified time for event
playback.
Note
● The timeline indicates the time duration for the video files, and the video files of different
types are color coded.
● You can use mouse wheel or click
/
to scale up or scale down the timeline bar.
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7.4 VCA Playback
You can set VCA rule to the searched video files and find the video that VCA event occurs, such as
motion detection, line crossing detection, and intrusion detection. This function helps to search
out the video that you may be more concerned and mark it with red color.
Steps
Note
For some devices, you can filter the searched video files by setting the advanced attributes, such
as the gender and age of the human and whether he/she wears glasses.
1. Enter the Remote Playback module.
2. Click
on the left to enter the Camera Playback page.
3. Select the camera and start the normal playback.
Note
Refer to Play Video Files for details.
4. Right‐click the display window to pop up the shortcut menu.
5. Click VCA Search and enable the VCA Type, draw the detection region and set the sensitivity.
Motion Detection
Get all the related motion detection events that occurred in the pre‐defined region.
Line Crossing Detection
Bi‐directionally detect people, vehicles and other moving objects that cross a virtual line.
Intrusion Detection
Detect whether there are people, vehicles and other moving objects intruding into the pre‐
defined region.
Note
You can click VCA Settings to set the sensitivity and filter the searched video files by setting the
target characters, such as the gender and age of the human and whether he/she wears glasses.
This function should be supported by the device.
6. Optional: Click
to set the start date and end date of searching time period.
7. Start the VCA playback.
The VCA events occurred in the defined area will be red marked on the timeline.
Note
● By default, the playback speed of concerned video will be 1X, and the playback speed of
unconcerned video will be 8X.
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● You can set to skip the unconcerned video during VCA playback in System Configuration and
the unconcerned video won't be played during VCA playback. Refer to Set Live View and
Playback Parameters for details.

7.5 Synchronous Playback
In synchronous playback, the video files can be played back in synchronization.
Perform this task when you need to play the video files in synchronization.
Steps
Note
Video files from up to 16 cameras can be played back simultaneously.
1. Enter the Remote Playback module.
2. Start playback of at least two cameras.
3. Click
in the toolbar to enable the synchronous playback.
The camera under playback will start synchronous playback.
4. Click
to disable the synchronous playback.

7.6 Playback in Low Bandwidth
In situation of low network bandwidth, the speed of video streaming might be much slower due to
the bandwidth limit. To provide normal quality in less streaming speed for low bandwidth users,
the client provides playback in low bandwidth mode. Before that, you need to set the streaming
protocol and perform other operations first.
For details about the settings, refer to How to get better performance of live view and playback
when network bandwidth is low?.
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Chapter 8 Download Video Footage
During playback, you can download the video files of one camera or multiple cameras to the local
PC.
Note
● You cannot download the video files of Cloud P2P device.
● For NVR which is added to the client by device's other user name (except admin), if Double
Verification is enabled on this NVR, when playing back videos on the client, you are required to
enter the user name and password created for double verification. For details about double
verification, refer to the user manual of the NVR.

8.1 Download Video Footage by Date
During playback, you can download the video footage of the camera and save in the local PC.
Steps
1. Enter Remote Playback page and select a camera to start playback.
Note
For details about starting playback, refer to Remote Playback.
2. Right click on the image and click Download.
3. Set the start and end time of the video footage to download.
4. Enter a name for the video footage.
5. Click OK to start downloading the video footage to the local PC.

8.2 Download Videos from Multiple Cameras
During the playback of multiple cameras, you can download the video files of multiple cameras by
date simultaneously.
Steps
1. Enter Remote Playback page and select multiple cameras to start playback.
Note
For details about starting playback, refer to Remote Playback.
2. Click
to open the Download for Multiple Cameras window.
All the cameras in playback will be displayed.
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3. Select the cameras you want to download video files for.
4. Set the start time and end time of video duration for each camera.
5. Optional: Check Download Player to download the player.
6. Click Download to start downloading the video files of the configured duration(s) to the local
PC.
The progress bar shows the downloading process of each camera's video files.
7. Optional: Click Stop to stop downloading manually.
Note
Up to 16 cameras' video files can be downloaded simultaneously.
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Chapter 9 Configure Video Event
Even if you are far away from the video device (cameras, alarm inputs and encoding devices,
decoding devices), you can still know what happens and how urgent the event is by configuring
linked actions of video event on the client. You will be notified on the client once an event is
triggered, so that you can response to the event instantly. You can also configure client actions of
video devices in a batch at a time.
Steps
1. Click Event Management → Video Event to enter the video event configuration page.
2. On the left panel, select the event source type: Camera, Alarm Input, or Device, and then select
the specific source in the device list.
Note
Make sure the device is online.
All the events supported by the selected device will be displayed.
3. Optional: Turn on the switch on the Enable column to enable the event, or click Enable All to
enable all the events of this device.
Note
After enabled, the event can be received by the software client and trigger the linkage action(s).
4. Optional: Turn off the switch on the Enable column to disable this event, or Click Disable All to
disable all the events of this device.
Note
After disabled, the event received by the software client can not trigger the linkage action(s).
5. Optional: Select the event(s), and then click Edit Priority to edit the priority of the event(s).
Note
Priority represents the emergency degree of the event.
6. Select the event(s), and then click Edit Event Linkage to edit the linkage action(s) of the
event(s).
Audible Warning
Trigger the client's audible warning when the event is triggered.
You can select the audio file on the drop‐down list, or click Add to add new audio file (in WAV
format).
You can click
to make an audition of the selected audio file.
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Send Email
Send an email notification of the alarm information to one or more receivers.
For details about setting email parameters, refer to Set Email Parameters.
Pop‐up Window
Pop‐up window to display the event related information (including event details, live video of
the source camera, captured pictures of the linked camera, process record, and process field)
on the software client when the event is triggered.
Display on Map
When the event source is added as a hot spot on the map, the hot spot will be displayed with
twinkling aside when the event is triggered, which helps to security guard to view the
location of the event.
You can also click the hot spot to view the event details and the live video of the linked
camera.
Linked Camera
Link the selected camera to capture picture when the event is triggered.
Select the camera in the drop‐down list.
7. Optional: Select the event(s), and then click Copy to to copy the event settings of this device to
other device(s).
Note
You can only copy the event settings to the device(s) with the same device type.
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Chapter 10 Event Center
In the Event Center, you can view the real‐time events, search the historical events and view the
pop‐up alarm information.
Before the client can receive the event information from the device, you need to arm the device
first. For details, refer to Enable Receiving Events from Devices.
Before the you can view the pop‐up alarm information, you need to enable alarm triggered pop‐up
image in the event center. For details, refer to View Pop‐up Alarm Information.

10.1 Enable Receiving Events from Devices
Before the client can receive the event information from the device, you need to arm the device
first.
Steps
1. Click
→ Tool → Device Arming Control open Device Arming Control page.
All the added devices display on this page.
2. In the Operation column, turn on the switch to enable auto‐arming, or click Arm All to arm all
the devices.
3. View the arming status of each device in the Arming Status column.
Result
The events of armed device(s) are automatically uploaded to the client when the event is
triggered.

10.2 View Real‐Time Events
In the Real‐time Event module of the event center page, you can view the real‐time event
information, including event source, event time, priority, event key words, etc.
Before You Start
Enable receiving events from devices before the client can receive event information from the
device, see Enable Receiving Events from Devices for details.
Steps
1. Click Event Center → Real‐time Event to enter the real‐time event page and you can view the
real‐time events received by the client.
Event Time
For video device, event time is the client time when it receives the event. For none‐video
device, event time is the time when the event is triggered.
2. Set the filter conditions or enter the event key word in the Filter text field to display the
required events only.
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Device Type
The type of device that occurred the event.
Priority
The priority of the event that indicates the urgent degree of the event.
3. Optional: Right click the table header of the event list to customize the event related items to be
displayed in the event list.
4. View the event information details.
1) Select an event in the event list.
2) Click Expand in the right‐lower corner of the page.
3) View the related picture, detail description and handing records of the event.
4) Optional: Hover the cursor on the related picture, and then click the download icon on the
upper‐right corner of the picture to download it to the local PC. You can set the saving path
manually.
5. Optional: Perform the following operations if necessary.
Handle Single Event

Click Handle to enter the processing suggestion, and then click
Commit.
Note
After an event is handled, the Handle button will become Add
Remark, click Add Remark to add more remarks for this handled
event.

Handle Events in a
Batch

Select events that need to be processed, and then click Handle in
Batch. Enter the processing suggestion, and then click Commit.

Enable/Disable
Alarm Audio

Click Enable Audio/Disable Audio to enable/disable the audio of the
event.

Select the Latest
Event Automatically

Check Auto‐Select Latest Event to select the latest event
automatically and the event information details is displayed.

Clear Events

Click Clear to clear the all the events in the event list.

Send Email

Select an event and then click Send Email, and the information details
of this event will be sent by email.
Note
You should configure the email parameters first, see Set Email
Parameters for details.
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10.3 Search Historical Events
In the Event Search module of the event center page, you can search the historical events via time,
device type, and other conditions according to the specified device type, and then process the
events.
Before You Start
Enable receiving events from devices before the client can receive event information from the
device,see Enable Receiving Events from Devices for details.
Steps
1. Click Event Center → Event Search to enter the event search page.
2. Set the filter conditions to display the required events only.
Time
The client time when the event starts.
Search by
Group: Search the events occurred on the resources in the selected group.
Device: Search the events occurred on the selected device.
Device Type
The type of device that occurred the event.
All
All the device types, and you can set the following filter conditions: group, priority, and
status.
Security Control Panel
For the events of security control panel, you can set the following filter conditions: device,
priority, acknowledgement status and event type.
Video Intercom
For the events of video intercom, you need to select searching scope: All Record and Only
Unlocking.
● All Records
● : You can filter the events from all the video intercom events, and you need to set the
following filter conditions: device, priority, status.
● Only Unlocking
● : You can filter the events from all the video intercom unlocking events, and you need to
set the following filter conditions: device, unlocking type.
Access Control
For the events of access control, you can set the following filter conditions: device, priority,
status, event type, card reader type, person name, card no., organization.
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Note
Click Show More to set the event type, card reader type, person name, card no.,
organization.
Group
The group of the device that occurred the event. You should set the group as condition only
when you select the Device Type as All.
Device
The device that occurred the event.
Priority
The priority including low, medium, high and uncategorized which indicates the urgent
degree of the event.
Status
The handling status of the event.
3. Click Search to search the events according the conditions you set.
4. Optional: Right click the table header of the event list to customize the event related items to be
displayed in the event list.
5. Optional: Handle the event(s).
– Handle single event: Select one event that need to be processed, and then click Handle in the
event information details page, and enter the processing suggestion.
– Handle events in a batch: Select the events which need to be processed, and then click
Handle in Batch, and enter the processing suggestion.
Note
After an event is handled, the Handle button will become Add Remark, click Add Remark to add
more remarks for this handled event.
6. Optional: Select an event and then click Send Email, and the information details of this event
will be sent by email.
Note
You should configure the email parameters first, see Set Email Parameters for details.
7. Optional: Click Export to export the event log or event pictures to the local PC in CSV format.
You can set the saving path manually.
8. Hover the cursor on the related picture, and then click the download icon on the upper‐right
corner of the picture to download it to the local PC. You can set the saving path manually.
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10.4 View Pop‐up Alarm Information
For the alarm configured with pop‐up image, the alarm videos and pictures can display on a pop‐up
window when the corresponding alarm is triggered.
Before You Start
Configure the alarm linkage action as Alarm Triggered Pop‐up Image.
Steps
1. Click Event Center on the control panel to enter the event center.
2. Click Real‐Time Event on the left panel.
3. Click Enable Alarm Triggered Pop‐up Image to enable alarm triggered pop‐up function.
4. Trigger the alarm.
A window, showing the alarm video, alarm picture, and alarm details, will pop up.
5. Perform the following operation(s) after popping up the image.
View Alarm Video

You can view the live video of the camera configured in Camera
Linkage.
Move the cursor over the video and click
to view instant playback
to see what happens when the alarm is triggered.
Click
to capture a picture of the live video and save the snapshot
on the PC running the client.
Click
to record the live video and save the recorded video footage
on the PC running the client.
Right‐click on the alarm video to perform other operations. For details,
refer to Live View.

View Alarm Picture

The alarm picture captured by the camera configured in Camera
Linkage will display on the field below the alarm video.

View Previous
Next Alarm
Handle Alarm

or Click Prev Page or Next Page to view the previous or next alarm
information.
For the first time to handle the alarm, click Handle to enter the
handling suggestion.
For the handled alarm, click Add Remark to add more the handling
suggestions.
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Chapter 11 Map Management
The E‐map function gives a visual overview of the locations and distributions of the installed cameras
and alarm input devices. You can get the live view of the cameras on the map, and you will get a
notification message from the map when alarm is triggered.
E‐map is a static image (it do not have to be geographical maps, although they often are. Depending
on your organization's needs, photos and other kinds of image files can also be used as e‐maps)
which gives you a visual overview of the locations and distributions of the hot spots (resources (e.g.,
camera, alarm input) placed on the map are called hot spots). You can see the physical locations of
the cameras and alarm inputs, and in what direction the cameras are pointing. With the function of
hot region, e‐maps can be organized into hierarchies to navigate from large perspectives to detailed
perspectives, e.g., from floor level to room level.

11.1 Add Map
You should add a map as the parent map for the hot spots and hot regions.
Steps
Note
Only one map can be added to one group.
1. Open the E‐map page.
2. Select a group for which you want to add a map.
Note
For details about setting the group, refer to Group Management.
3. Click Add Map to open the map adding window.
4. Enter a descriptive name of the added map.
5. Select a map picture from the local path.
Note
The picture format of the map can only be PNG, JPEG or BMP.
6. Click OK.
7. Optional: Perform the following tasks after adding the map.
Zoom in/out

Use the mouse wheel or click + or ‐ to zoom in or zoom out on the
map.

Adjust Map Area

Drag the yellow window in the lower‐right corner or use the direction
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buttons and zoom bar to adjust the map area for view.

11.2 Edit Map Scale
The scale of a map is the ratio of a distance on the map to the corresponding distance on the
ground. The client can calculate two locations' distance on the map according to the distance on
the ground. An accurate map scale is essential for defining radar's monitoring range.
Before You Start
Make sure you have added a map. See Add Map for details.
Perform this task if you need to add a security radar to the map.
Steps
1. Enter the E‐map module.
2. Click Edit on the E‐map toolbar to enter the map editing mode.
3. Click Edit Scale to select two locations on the map.
The cursor will turn to
if you hover it on the map.
4. Click on the map to select two locations.
The Edit Scale window pops up.
5. Enter the ground distance between the two locations, and then click OK.
The client will calculate the map scale automatically.

11.3 Manage Hot Spot
The devices added to the map are called hot spots. The hot spots show the locations of the
devices, and you can also get the live view or alarm information of the surveillance scenarios
through the hot spots. The devices can be added to the map as hot spots includes: camera, alarm
input/output, access point, security radar, and zone.

11.3.1 Add Camera as Hot Spot
You can add cameras to the map as hot spots.
Before You Start
Make sure you have added an e‐map and a camera to the client. See Add Map and Device
Management for details.
Steps
1. Enter the E‐map page.
2. Click Edit in the upper‐right corner to enter the map editing mode.
3. Click Add Hot Spot → Camera Hot Spot to open the Add Hot Spot window.
4. Select the cameras to be added to the map.
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5. Optional: Edit the hot spot name, select the name color and select the hot spot icon.
6. Click OK to save the settings.

Note
You can also drag the camera icons from the group list to the map directly to add the hot spots.

The camera icons are added on the map as hot spots and the icons of the added cameras in the
group list change from
to . The sector indicates the camera's field of view.
7. Perform the following operation(s).
Move the Hot Spot

Drag the hot spot to move it to a certain position.

Change the FOV
Angle

Drag

/

Change the FOV Size

Drag

to change the FOV size.

and revolve to change the camera's field of view.

11.3.2 Add Alarm Input as Hot Spot
You can add the alarm inputs to the map as hot spots.
Steps
1. Enter the E‐map module.
2. Click Edit in the upper‐right corner to enter the map editing mode.
3. Click Add Hot Spot → Alarm Input Hot Spot to open the Add Hot Spot window.
4. Select the alarm inputs to be added to the map.
5. Optional: Edit hot spot name, select the name color and select the hot spot icon by double‐
clicking the corresponding field.
6. Click OK.

Note
You can also drag the alarm input icons from the group list to the map directly to add the hot
spot.

The alarm input icons are added to the map as hot spots and the icons of the added alarm
inputs in the group list change from
to .
7. Optional: Drag the hot spot to move it to a certain position.
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11.3.3 Add Alarm Output as Hot Spot
You can add alarm outputs to the map as hot spots for management. After that, you can enable or
disable it in a quick manner. If you enable an alarm output on the map, the security control
devices (e.g. sirens, bells) connected to it will alarm for attention.
Before You Start
Make sure you have added an e‐map and alarm output to the client. See Add Map and Device
Management for details.
Steps
1. Enter the E‐map module.
2. Click Edit on the E‐map toolbar to enter the map editing mode.
3. Click Add Hot Spot → Alarm Output Hot Spot to open the Add Hot Spot panel.
4. Select the alarm output to be added to the map.
5. Optional: Edit the hot spot name, select the name color, and select the hot spot icon.
6. Click OK.
Note
You can also drag an alarm output icon from the alarm output list to the map to add the hot
spot.

The alarm output is added to the map as a hot spot and its icon in the group list changes from
to .
7. Optional: Drag the alarm output to move it to a certain position.

11.3.4 Add Zone as Hot Spot
You can add zones to the map so that you can quickly locate the zone when an alarm is triggered.
Before You Start
Make sure you have added a map and zone to the client. See Add Map and Add Device for details.
Steps
1. Enter the E‐map module.
2. Click Edit on the E‐map toolbar to enter the map editing mode.
3. Click Add Hot Spot → Zone Hot Spot to open the Add Hot Spot panel.
4. Select the zone(s) to be added to the map.
5. Optional: Edit the hot spot name, select the name color, and select the hot spot icon.
6. Click OK.
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Note
You can also drag the alarm output icons from the alarm output list to the map to add the hot
spot.

The zone is added to the map as a hot spot and its icon in the group list changes from
to
7. Optional: Drag the zone hot spot to move it to a certain position.
When alarms are triggered, the number of the newest alarms will be displayed on the zone's
icon. You can click the number to see the alarms details.
Note
No more than 10 newest alarms can be displayed.
8. Optional: Click Clear Alarms to mark the alarms of the zones on the current map as read.

11.3.5 Add Security Radar as Hot Spot
For an effective monitoring, you can add a security radar to the map as a hot spot and paint zones
in its monitoring filed. So that when someone intrudes the zone, an alarm will be triggered for
attention.
Before You Start
Make sure you have added an e‐map and a security radar to the client. See Add Map and Device
Management for details.
Steps
1. Enter the E‐map module.
2. Click Edit on the E‐map toolbar to enter the map editing mode.
3. Optional: Edit map scale. See Edit Map Scale.
4. Select a security radar in the device list and drag it to the map.
5. Optional: Click the added radar and then click
to edit the hot spot name, select the hot spot
color, and select the hot spot icon.
6. Click OK.
The security radar is added to the map as a hot spot and its icon in the group list changes from
to . The sector indicates the monitoring field of the radar.
Note
● Orange sector indicates an armed radar, while black sector indicates a disarmed radar.
● Red point indicates the detected intruder.
7. Add zone to the monitoring field of the security radar.
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Note
Make sure the security radar is disarmed.
1) Click Edit → Add Radar Zone to start painting a zone.
2) Optional: Switch the Field Assistance onto enable zone painting assistance function.
Example
Person A takes an on‐site walk in the field which needs to be painted as a zone, which will be
indicated as a moving pattern consists with red points and dashed lines. And then Person B
paints a zone on the map according to the moving pattern.
3) Click in the sector to paint a zone and right‐click to complete painting.
Zone Settings window pops up.
4) Enter a zone name and select a zone type.
Warning Zone
Defined by red line. If someone intrudes the warning zone, an alarm will be triggered with
the whole zone turning to red. And the intruder's location and moving pattern will be
displayed with a red point connected by a red dashed line. Only if the intruder goes out of
the zone, the zone restores.
Pre‐Warning Zone
Defined by blue line. If someone intrudes the warning zone, an alarm will be triggered and
you can view the event details in the Event Center.
Disabled Zone
Defined by purple line. If someone intrudes the warning zone, no alarm will be triggered,
and moving pattern will not be displayed.
5) Optional: Edit a zone: double‐click a zone to enter editing mode of the zone (a dashed‐line
frame will be displayed around the zone). Hover the cursor on the edge of the zone to show a
blue +, click to add a point for the zone. Drag a point to change the zone. Click any other place
to quit editing mode.
8. Optional: Drag the security radar to move it to a certain position.

11.3.6 Add Access Point as Hot Spot
You can add access points to the map as hot spots, so that you can find the hot spots and view
their status and alarm numbers.
Before You Start
Make sure you have added a map and an access point to the client. See Add Map and Add Device
for details.
Steps
1. Enter the E‐map module.
2. Click Edit on the E‐map toolbar to enter the map editing mode.
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3. Click Add Hot Spot → Access Point Hot Spot to open the Add Hot Spot window.
4. Select the access point(s) to be added to the map.
5. Optional: Edit the hot spot name, select the name color, and select the hot spot icon.
6. Click OK.
Note
You can also drag an access point icon from the access point list to the map.
The access point is added to the map as a hot spot and its icon in the group list changes from
to .
7. Optional: Drag the access point hot spot to move it to a certain position.
When alarms are triggered, the number of the newest alarms will be displayed on the hot spot
icon. You can click the number to see the alarms details.
Note
No more than 10 newest alarms can be displayed.

11.3.7 Edit Hot Spot
You can edit the information of the added hot spots on the map, including the name, the color,
the icon, etc.
Steps
1. Enter the E‐map module.
2. Click Edit in the upper‐right corner to enter the map editing mode.
3. Select the hot spot icon on the map and then click
to open the Edit Hot Spot window.
4. Edit the hot spot name in the text field, select the hot spot name's color and hot spot icon
shown on the map.
5. Check Apply to Other Camera Hot Spots/Apply to Other Alarm Input Hot Spots/Apply to Other
Alarm Output Hot Spots/Apply to Other Zone Hot Spots to apply the color and icon settings to
other hot spots.
6. Click OK.
7. Optional: Select the hot spot icon and click
to delete the hot spot.

11.3.8 Preview Hot Spot
After adding hot spots (including camera, alarm input/output, zone, security radar, and zone) to
the map, you can view the live view of the camera hot spot and the triggered alarm information of
all the types of hot spots on the map.
Before You Start
Make sure you have added hot spots to the map. See Manage Hot Spot for details.
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Steps
1. Enter the E‐map module.
Note
If you are in the editing map mode, click Exit on the upper‐right corner to enter the map
preview mode.
2. Click Display to show the hot spots on the map.
Note
Hot spot type with

will be shown on the map.

3. Click a hot spot to perform the following operation(s).
Hot Spot
Live View: Click
to pop up the live view window of the camera.
TypeOperationsCame
Note
ra
● When an alarm is triggered during live view, the client will play a
video file of 30 s first.
● You can capture, start recording and instant playback during live
view.

Alarm Output

Click an alarm output, and select Open/Close.
Note
The security control channels managed by the alarm output will also
be opened/closed.

Access Point

View door status: the current door status of the access point is
displayed on the icon. Click the icon to switch the door status.

Open Door
When the door is locked, unlock it and it will be open for once. After the open duration, the door
will be closed and locked again automatically.
Close Door
When the door is unlocked, lock it and it will be closed. The person who has the access
authorization can access the door with credentials.
Remain Open
The door will be unlocked (no matter closed or open). All the persons can access the door with no
credentials required.
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Remain Closed
The door will be closed and locked. No person can access the door even if he/she has the
authorized credentials, except the super users.

Arm/Disarm zones in the monitoring field of the radar: After exiting
editing, click the icon of a security radar, and then select Arm/Disarm.
4. Optional: Perform the following operation(s).
View Alarm
Information

Click the alarm number on a hot spot icon to open the alarm
information page to view the alarm type and triggering time.

Clear Alarm

Click Clear Alarm on the top of the map to mark all the alarms of the
hot spot as read.

View Multiple
Cameras' Live View
on the Map

1. Click Live View to show 4 small windows on the bottom of the
client.
2. Drag a camera from the device list to a window to start the live
view.
Note
Up to 4 cameras' live view is supported at the same time.

11.4 Manage Hot Region
The hot region function links a map to another map. When you add a map to another map as a hot
region, an icon of the link to the added map is shown on the main map. The added map is called
child map while the map to which you add the hot region is the parent map.
After linking a child map to a parent map, a hot region icon will display on the parent map. You can
click it to enter the child map to view the resources on the child map for convenience.
With the function of hot region, e‐maps can be organized into hierarchies to navigate from large
perspectives to detailed perspectives, e.g., from floor level to room level.

11.4.1 Add Hot Region
You can add a map to another map as a hot region and an icon of the link to the added map is
shown on the main map. The added map is called child map while the map to which you add the
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hot region is the parent map.
Before You Start
At least two maps should be added. Refer to Add Map for details about adding maps.
Steps
Note
A map can only be added as the hot region for once.
1. Enter the E‐map page.
2. Click Edit on the upper‐right corner to enter the map editing mode.
3. Select an added map as the parent map.
4. Click Add Hot Region to open the Add Hot Region window.
5. Select the child map.
6. Optional: Edit the hot region name, and select the hot region color and icon by double‐clicking
the corresponding field.
7. Click OK.
The child map icons are added on the parent map as the hot regions.

11.4.2 Edit Hot Region
You can edit the information of the hot regions on the parent map, including name, color, icon,
etc.
Steps
1. Enter the E‐map module.
2. Click Edit on the upper‐right corner to enter the map editing mode.
3. Select a hot region icon on the parent map and click
to open the Edit Hot Region window.
4. Edit the hot region name in the text field, select the hot region name's color and hot region
icon.
5. Check Apply to Other Hot Regions to apply the color and icon settings to other hot regions.
6. Click OK.

11.4.3 Preview Hot Region
After adding a hot region, you can click the hot region icon on the parent map to enter the child
map. You can view the resources and alarms on the child map.
Steps
1. Enter the E‐map page.
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Note
If you are in the editing map mode, click Exit on the upper‐right corner to enter the map
preview mode.
2. Click the hot region icon on the parent map to enter the linked child map.
You can view the resources on the child map. If there is any alarm triggered on the child map,
you can view the alarm details.
3. Optional: Click Back to Parent Map on the upper‐left corner to go back to the parent map.
4. Optional: Click Clear Alarm Info. on the upper‐right corner to clear the alarm information
triggered by the resources on the current map.

67

Mira

Chapter 13 Forward Video Stream through Stream
Media Server
There is always a limit of the device remote access number. When there are many users wanting
to get remote access to the device to get the live view, you can add the stream media server and
get the video data stream from the stream media server, thus to lower the load of the device.
Note
The stream media server application software needs to be installed and it is packed in the client
installation package. After running the installation package, check Stream Media Server to enable
the installation of stream media server.

13.1 Import Certificate to Stream Media Server
Before adding the stream media server to the client, you should import the client's security
certificate to the stream media server first to perform security authentication and ensure data
security.
Perform the following steps to import the security certificate to the stream media server.
Steps
1. Export the certificate from the client.
1) Open client service.
2) Click Export.
2. Copy the certificate to the PC which has installed with stream media server.
3. Click
on the desktop of the PC installed with stream media server to run it.
4. Import the certificate to the stream media server.
1) Right click
on the task bar and click Display.
2) Click Configuration to enter the Configuration window.
3) In the security certificate field, click Import and select the certificate file you export from
client in Step 1.
4) Click OK.
5. Restart the stream media server to take effect.
Note
If the client's security certificate is updated, you should export the new certificate from the
client and import it to the stream media server again to update.
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13.2 Add Stream Media Server by IP Address
You can add stream media server by IP address one by one.
Steps
Note
For one client, up to 16 stream media servers can be added.
1. Click

on the desktop to run the stream media server.

Note
● You can also forward the video through the stream media server installed on other PC.
● If the stream media server port (value: 554) is occupied by other service, a dialog box will pop
up. You should change the port No. to other value to ensure the proper running of the stream
media server.
2. In the client software, enter the Device Management page.
3. Enter Device → Stream Media Server
4. Click Add to open the Add window.
5. Select IP Address as the adding mode.
6. Enter the nickname and IP address of the stream media server.
Note
The default port value is 554.
7. Finish adding the stream media server.
– Click Add to add the server and back to the list page.
– Click Add and Continue to save the settings and continue to add other server.
Note
If the added Stream Media Server's security certificate doesn't match with the client's, it will
prompt you. You can view exception message and follow the provided steps to keep certificates
consistent.

13.3 Add Cameras to Stream Media Server to Forward Video
Stream
To get the video stream of a camera via stream media server, you need to connect the camera to
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the stream media server.
Steps
1. Enter the Device Management module.
2. Enter Device → Stream Media Server
3. Select a server and click
on Operation column to open Stream Media Server Settings
window.
4. Select the cameras of which the video stream is to be forwarded via the stream media server.
5. Click OK.
6. Go the Main View page and start the live view of the cameras again.
On the stream media server control panel, check the channel number of the video stream
forwarded through or sent from the stream media server.
Note
● For one stream media server, up to 64 channels of video stream can be forwarded through it
and up to 200 channels of video stream can be sent to clients from it.
● If the camera is offline, the client can still get the live video via the stream media server.
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Chapter 14 Statistics
Reports, created for a specified period, are essential documents, which are used to check whether
a business runs smoothly and effectively. In this software, reports can be generated daily, weekly,
monthly, annually, and by custom time period. You can use reports as basis in creating decisions,
addressing problems, checking tendency and comparison, etc.

14.1 People Counting Report
People counting statistics is to calculate the number of line crossing people in a specific area and a
certain time period by the people counting camera(s), which can help the storekeeper to analyze
the customers flow and number in different time, and the storekeeper can flexibly do some
business adjustment according to the report. You can view the people counting statistics in a line
chart or histogram, and generate reports for exporting the detailed data to local storage.
Before You Start
Add a people counting device to the software and properly configure the corresponding area. The
added device should have been configured with people counting rule. Refer to Add Device for
details about adding people counting device.
Steps
1. Click Report → People Counting to enter People Counting page.
2. Select daily report, weekly report, monthly report, or annual report as the report type.
Daily Report
Daily report shows data on a daily basis. The system will calculate the number of people in a
each hour of one day.
Weekly Report, Monthly Report and Annual Report
As compared to daily report, weekly report, monthly report and annual report can be less‐
time consuming, since they are not to be submitted every day. The system will calculate the
number of people in each day of one week, in each day of one month, in each month of one
year.
3. Select the statistics time type and click
to set the time.
One Period
Generate the statistics in one time period.
Multiple Periods
Generate the statistics in two time periods, which can help you to compare the people flow
and number in two time periods.
For example, if you set the report type as month report, and set the March and April as the
statistic time, the people counting results in March and April will be displayed in a same chart
with different color, and you can compare the data in different day of each month.
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4. On the upper‐right corner of the page, select Display by Device or Display by Camera.
Display by Device
Display the report by device.
For example, if you select one NVR (with 4 people counting cameras), the report will display
the total number of people summed by the 4 people counting cameras.
Display by Camera
Display the report by camera.
For example, if you select one NVR (with 4 people counting cameras), the report will display
the each camera's statistics respectively, namely display the statistics in 4/8 colors (each/2
color represent one camera).
5. On the upper‐right corner of the page, select Display by Device or Display by Camera.
Display by Device
Display the report by device.
You can select only one device with multiple people counting cameras inside, or select only
one people counting camera to be displayed.
For example, if you select one NVR with 2 people counting cameras inside, the report will
display the total number of people summed by the 2 cameras.
Display by Camera
Display the report by camera.
You can only select one people counting camera to be displayed.
6. Select the people counting camera(s) to be displayed.
7. Select the direction for statistics.
Entered
The people entered will be counted.
Exited
The people exited will be counted.
Passed
Both people entered and exited will be counted.
8. Click Search to get the people counting statistics and detailed data for each hour, day, or
month.
By default, the statistics are shown in histogram form.
9. Optional: Perform the following operations after search.
Switch to Line Chart

Click

to switch it to line chart.

Note
By default, the statistics are shown in bar chart.
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Switch to Bar Chart

Click

to switch it to bar chart.

Save to Local PC

Click Export to save the detailed data of people counting to your PC.

14.2 View People Counting in Intersections Report
Intersection analysis is used to monitor people flow and number in an intersection‐like scene. The
arrows in the image refer to different directions. By selecting one direction (e.g. A) as the
entrance, the other directions will be set as the exits by default, so that multiple paths are
generated (e.g., A to A, A to B, A to C, and A to D). You can view the people counting who passed
by each path, respectively, which can help the shopkeeper to analyze the people flow in different
door. The statistics result can show in daily, weekly, monthly, and annual report.
Before You Start
Make sure a fisheye camera which supports intersection analysis function has been configured
properly and be added to the software. Refer to Add Device for details about adding the device.
Steps
Note
Up to 10 intersections can be analyzed.
1. Click Report → Intersection Analysis to enter the intersection analysis module.
2. Select daily report, weekly report, monthly report, or annual report as the report type.
Daily Report
Daily report shows data on a daily basis. The system will calculate the number of people in
intersection report in a each hour of one day.
Weekly Report, Monthly Report and Annual Report
As compared to daily report, weekly report, monthly report and annual report can be less‐
time consuming, since they are not to be submitted every day. The system will calculate the
number of people in intersection report in each day of one week, in each day of one month,
in each month of one year.
3. Set the start time for the report.
4. Select the camera for generating the report.
5. Select one direction as the entrance from the drop‐down list in the Flow in filed.
6. Click Search to get the statistics result.
The people number for each path will show on the right.
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14.3 Queue Management
Queue management supports data analysis and report output from multiple dimensions.
Commonly Used Data Analysis
● To see queuing‐up people number of a certain waiting time level in a queue/region, use
queuing‐up time analysis, check a target region and set a waiting time level.
● To compare queuing‐up people number of a certain waiting time level in multiple
queues/regions, use queuing‐up time analysis, check target regions and set a waiting time level.
● To compare queuing‐up people number of different waiting time levels in multiple
queues/regions, use queuing‐up time analysis, check target regions and set waiting time levels.
● To see the time and duration that a queue stays a certain length in a queue/region, use queue
status analysis, check a target region and set a queue length level.
● To compare the time and duration that a queue stays a certain length in multiple
queues/regions, use queue status analysis, check target regions and set a queue length level.
● To compare the time and duration that a queue stays at different length in multiple
queues/regions, use queue status analysis, check target regions and set queue length levels.

14.3.1 Queuing‐Up Time Analysis
Queuing‐Up Time Analysis calculates people number of different waiting time levels. Regional
comparison and multiple waiting time level comparison are supported.

Compare Queuing‐up People Amount for Different Regions
You can search the queuing‐up people amount for a certain waiting time level, and compare the
people amount in different regions, which can help the storekeeper to analyze the customers'
interested area (e.g, the regions with larger people amount are more popular than the regions
with lower people amount，and you can arrange more goods in these regions.) . The statistics
data can show in daily report, weekly report, or monthly report.
Before You Start
Add the device to the software and properly configure the corresponding settings. See Add Device
for details about adding the device.
Steps
Note
This function should be supported by the connected device.
1. Click Report → Queue Management to enter the queue management page.
2. Click Queuing‐up Time Analysis Tab.
3. Select the report type including Daily Report, Weekly Report and Monthly Report.
Daily Report
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Daily report shows data on a daily basis. The system will calculate the people amount for
different regions in a each hour of one day.
Weekly Report, Monthly Report
As compared to daily report, weekly report and monthly report can be less‐time consuming,
since they are not to be submitted every day. The system will calculate the people amount for
different regions in each day of one week, in each day of one month.
4. Set the statistic time.
5. Click
to unfold the region list and select the region(s).
Note
Up to 6 regions can be selected.
6. Select Regional Comparison as the report content.
7. Select a waiting time level and enter the seconds for calculating people amount waiting for the
specified time period.
8. Click Search to generate the statistics result.
The line chart of the calculated people amount in the specified waiting time will show on the
result area. The lines with different colors indicate the people from the selected regions.
9. Optional: Click Export to export the data in Excel file.

Compare Queuing‐up People Amount for Different Waiting Time Levels
For a certain region, the queuing‐up people amount can be calculated according to the waiting
time level (e.g. the waiting time is shorter than the specified seconds.). You can search and
compare the people amount for the multiple waiting time levels, which can help the customers to
analyze the cashier efficiency. The statistics data can show in daily report, weekly report, or
monthly report.
Before You Start
Add the device to the software and properly configure the corresponding settings. See Add Device
for details about adding the device.
Steps
Note
This function should be supported by the connected device.
1. Click Report → Queue Management to enter the queue management page.
2. Click Queuing‐up Time Analysis Tab.
3. Select the report type including Daily Report, Weekly Report and Monthly Report.
Daily Report
Daily report shows data on a daily basis. The system will calculate the queuing‐up people
amount for different waiting time levels in a each hour of one day.
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Weekly Report, Monthly Report
As compared to daily report, weekly report and monthly report can be less‐time consuming,
since they are not to be submitted every day. The system will calculate the queuing‐up
people amount for different waiting time levels in each day of one week, in each day of one
month.
4. Set the statistic time.
5. Click
to unfold the region list and select the region(s).
6. Select Multi‐level Comparison as the report content.
7. Select the waiting time level and enter the seconds for calculating people amount waiting for
the specified time period.
8. Click Search to generate the statistics result.
The line chart of the calculated people amount in the same region will show on the result area.
The lines with different colors match the waiting time levels.
9. Optional: Click Export to export the data in Excel file.

14.3.2 Queue Status Analysis
Queue Status Analysis calculates the time and duration that a queue stays with a certain length.
Regional comparison and multiple queue length level comparison are supported.

Compare Queuing‐up Duration for Different Regions
When the queue stays at a certain length, you can search and compare the durations in different
regions, which can help the customers to analyze the cashier efficiency for different regions (e.g.,
the region with the shorter queuing‐up duration has the higher efficiency than the region with the
longer queuing‐up duration). The statistics data can show in daily report, weekly report or monthly
report.
Before You Start
Add the device to the software and properly configure the corresponding settings. See Add Device
for details about adding the device.
Steps
Note
This function should be supported by the connected device.
1. Click Report → Queue Management.
2. Click Status Analysis Tab.
3. Select the report type including Daily Report, Weekly Report and Monthly Report.
Daily Report
Daily report shows data on a daily basis. The system will calculate the queuing‐up duration for
different regions in a each hour of one day.
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Weekly Report, Monthly Report
As compared to daily report, weekly report and monthly report can be less‐time consuming,
since they are not to be submitted every day. The system will calculate the queuing‐up
duration for different regions in each day of one week, in each day of one month.
4. Set the statistic time.
5. Click
to unfold the region list and select the region(s).
6. Select Regional Comparison as the statistics type.
7. Select a queue length level and enter the value for calculating duration when the queue stays at
the length.
8. Click Search to generate the statistics result.
The line chart of the calculated duration for staying the specified queue length will show on the
result area. The lines with different colors match the selected regions.
9. Optional: Click Export to export the data in Excel file.

Compare Queuing‐up Duration for Different Queue Length Levels
For the queue in a certain region, you can search the duration when a queue stays a certain length
and compare the durations for different queue length levels, which can help the customers to
analyze the cashier efficiency of different queue length levels. The statistics data can show in daily
report, weekly report, or monthly report.
Before You Start
Add the device to the software and properly configure the corresponding settings. See Add Device
for details about adding the device.
Steps
Note
This function should be supported by the connected device.
1. Click Report → Queue Management.
2. Click Status Analysis Tab.
3. Select the report type including Daily Report, Weekly Report and Monthly Report.
Daily Report
Daily report shows data on a daily basis. The system will calculate the queuing‐up duration for
different queue length levels in a each hour of one day.
Weekly Report, Monthly Report
As compared to daily report, weekly report and monthly report can be less‐time consuming,
since they are not to be submitted every day. The system will calculate the queuing‐up
duration for different queue length levels in each day of one week, in each day of one month.
4. Set the statistic time.
5. Click
to unfold the region list and select the region(s).
6. Select Multi‐level Comparison as the report content.
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7. Select the queue length level and enter the value for calculating duration when the queue stays
at the length.
8. Click Search to generate the statistics result.
The line chart of the calculated duration in the same region will show on the result area. The
lines with different colors match the queue length levels.
9. Optional: Click Export to export the data in Excel file.

14.4 Heat Map Report
Heat map is a graphical representation of data represented by colors and the heat map data can
be displayed in line chart. You can use the heat map function of the camera to analyze the visit
times and dwell time of customers in a configured area, which can help the storekeeper analyze
the customers' interested area and make the arrangement of goods.
Before You Start
Add a heat map network camera to the software and properly configure the corresponding area.
The added camera should have been configured with heat map rule. See Add Device for details
about adding heat map network camera.
Steps
1. Click Report → Heat Map to enter the heat map page.
2. Select daily report, weekly report, monthly report, or annual report as the time type for the
report.
Daily Report
Daily report shows data on a daily basis. The system will calculate the data of heat map in a
each hour of one day.
Weekly Report, Monthly Report and Annual Report
As compared to daily report, weekly report, monthly report and annual report can be less‐
time consuming, since they are not to be submitted every day. The system will calculate the
data of heat map in each day of one week, in each day of one month, in each month of one
year.
3. Select By Dwell Time or By People Number as the statistics type.
By Dwell Time
The system calculates the heat map value (the ordinate value in the line chart or the color in
pictures) according to the people's dwell time.
By People Number
The system calculates the heat map value (the ordinate value in the line chart or the color in
pictures) according to the people number.
4. Set the start time.
5. Select a heat map camera in the camera list.
6. Click Generate Heat Map to show the heat map of the camera.
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7. Optional: After generating heat map report, you can perform the following operations.
Display in Line Chart

Click

to display the statistics in line chart.

Display in Picture
Mode

Click
to display the statistics in picture mode.
The red color block (255, 0, 0) indicates the most welcome area, and
blue color block (0, 0, 255) indicates the less‐popular area.

Save Statistics Data

Click Export to save the detailed data of heat map to your PC.

79

Mira

Chapter 15 Data Retrieval
In the Data Retrieval module, you can search the face pictures captured by the face recognition
camera, search the human body pictures captured by DeepinMind device, view behavior analysis
related pictures and videos, search the vehicle pictures captured by DeepinMind device, search
the frequently appeared person pictures captured by DeepinMind device, and search the not
wearing hard hat pictures.

15.1 Face Picture Retrieval
When the connected device (e.g. NVR or HDVR) supports face search, you can search the related
picture and play the picture related video file.

15.1.1 Search Face Picture by Uploaded Picture
You can upload a face picture from your PC and compare the uploaded picture with the captured
face pictures.
Before You Start
Add the device to the software and properly configure the corresponding settings. Refer to Add
Device for details about adding the device.
Steps
Note
This function should be supported by the connected device.
1. Click Data Retrieval → Face Picture Retrieval to enter the face picture retrieval page.
2. Click
to set the start time and end time for searching the captured face pictures or video
files.
3. Select device(s) in the camera panel.
4. Select Picture from the drop‐down list to search by picture.
5. Select a face picture for search.
1) Click Select Picture to upload the pictures from your PC.
2) Select a detected face from uploaded picture for matching the captured face pictures.
Note
● The resolution of the picture should be smaller than 4096×4080.
● Only JPG and JPEG formats are supported.
6. Set the similarity level.
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Example
If you set the similarity as 40, the captured pictures have no less than 40% similarity with the
uploaded face picture will list.
7. Set the maximum number of displayed results.
8. Click Search to start searching.
The search results of the pictures are displayed in list.
9. Export the pictures and save them in your PC.
Export Picture
Select the pictures to be exported and save them in local PC.
Export Current Page
Export all the pictures in the current page.
Export Segment
You can download the pictures by packages. Each package contains up to 1,000 pictures.
10. Optional: Perform secondary search based on the search result.
1) Move to the searched picture and click
All the faces in this picture will be analyzed and displayed.
2) Select a face you want to do secondary search.
3) Set the similarity and time period.
4) Click Search.
The client will search and compare the faces in the captured pictures based on the face
picture you selected.
11. Optional: After searching, you can do one or more the following operations.
View Details

Click on a picture from the list to view details. You can also click
to show the large picture, and click
to restore.

Play Related Videos

Click Playback to play the picture's related video file (5s before and 5s
after the capture) in the view window on the bottom right.
Note
● You can click
to show the large video, and click
to restore.
● You can click
to adjust the play speed of the playback, click
to play back the video files frame by frame, click
to enable
audio, double‐click the playback window to maximize the window.

Save Pictures to PC

Click Export Picture and select the pictures as desired to export to
local PC.
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15.1.2 Search Face Picture by Event
You can search the device's captured face pictures by filtering different event types.
Before You Start
Add the device to the software and properly configure the corresponding settings. Refer to Add
Device for details about adding the device.
Steps
Note
This function should be supported by the connected device.
1. Click Data Retrieval → Face Search to enter the face picture retrieval page.
2. Click
to set the start time and end time for searching the captured face pictures or video
files.
3. Select device(s) in the camera panel.
4. Select Event Type from drop‐down list to search by event type.
5. Select event type.
All
Search all captured face pictures.
Face Picture Comparison
Search the captured pictures which match with the face pictures in face picture library.
Stranger Detection Alarm
Search the pictures captured when the stranger detection alarm is triggered.
6. Set the maximum number of displayed results.
7. Click Search to start searching.
The search results of the pictures are displayed in list.
8. Export the pictures and save them in your PC.
Export Picture
Select the pictures to be exported and save them in local PC.
Export Current Page
Export all the pictures in the current page.
Export Segment
You can download the pictures by packages. Each package contains up to 1,000 pictures.
9. Optional: Perform secondary search based on the search result
1) Move to the searched picture and click
All the faces in this picture will be analyzed and displayed.
2) Select a face you want to do secondary search.
3) Set the similarity and time period.
4) Click Search.
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The client will search and compare the faces in the captured pictures based on the face
picture you selected.
10. Optional: After searching, you can do one or more the following operations.
View Details

Click on a picture from the list to view details. You can also click
to show the large picture, and click
to restore.

Play Related Videos

Click Playback to play the picture's related video file (5s before and 5s
after the capture) in the view window on the bottom right.
Note
● You can click
to show the large video, and click
to restore.
● You can click
to adjust the play speed of the playback, click
to play back the video files frame by frame, click
to enable
audio, double‐click the playback window to maximize the window.

Save Pictures to PC

Click Export Picture and select the pictures as desired to export to
local PC.

15.1.3 Search Face Picture by Person Name
You can search the device's captured face pictures by person name.
Before You Start
Add the device to the software and properly configure the corresponding settings. Refer to Add
Device for details about adding the device.
Steps
Note
This function should be supported by the connected device.
1. Click Data Retrieval → Face Search to enter the face picture retrieval page.
2. Select device(s) in the camera panel.
3. Select Name from the drop‐down list to search by person name.
4. Click
to set the start time and end time for searching the captured face pictures or video
files.
5. Enter a keyword for the person name.
6. Set the maximum number of displayed results.
7. Click Search to start searching.
All the persons whose name match the search condition (fuzzy match is supported) will be
displayed.
8. Select one picture to search, and then click Confirm.
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The search results of the pictures are displayed in list.
9. Export the pictures and save them in your PC.
Export Picture
Select the pictures to be exported and save them in local PC.
Export Current Page
Export all the pictures in the current page.
Export Segment
You can download the pictures by packages. Each package contains up to 1,000 pictures.
10. Perform secondary search based on the search result.
1) Move to the searched picture and click
All the faces in this picture will be analyzed and displayed.
2) Select a face you want to do secondary search.
3) Set the similarity and time period.
4) Click Search.
The search results of the pictures are displayed in list.
11. After searching, you can do one or more the following operations.
View Details

Click on a picture from the list to view details. You can also click
to show the large picture, and click
to restore.

Play Related Videos

Click Playback to play the picture's related video file (5s before and 5s
after the capture) in the view window on the bottom right.
Note
● You can click
to show the large video, and click
to restore.
● You can click
to adjust the play speed of the playback, click
to play back the video files frame by frame, click
to enable
audio, double‐click the playback window to maximize the window.

Save Pictures to PC

Click Export Picture and select the pictures as desired to export to
local PC.

15.2 Human Body Picture Retrieval
For the DeepinMind device, you can upload a human body picture from local PC and compare the
uploaded picture with the device's captured human body pictures, or search all the human body
pictures captured by the specific camera(s) during a specific time.
Before You Start
Add the device to the software and properly configure the corresponding settings. Refer to Add
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Device for details about adding the device.
Steps
Note
This function should be supported by the connected device.
1. Click Data Retrieval → Human Search to enter the face picture retrieval page.
2. Click
to set the start time and end time for searching the captured human body pictures or
video files.
3. Select device(s) in the camera panel.
4. Select the search condition in the Search by field.
Picture
Upload a picture to compare the uploaded picture with the device's captured human body
pictures. All the human bodies in this picture will be analyzed and displayed.
1. Click Select Picture to select a picture for comparison from local PC.
Note
● The picture should be smaller than 4 MB.
● The resolution of the picture should be smaller than 4096*4080.
● Only JPG and JPEG formats are supported.
2. Set the similarity level. For example, if you set the similarity as 40, the captured
pictures have no less than 40% similarity with the uploaded human body picture will
list.
None
Search all the pictures captured by the selected camera(s) during the time duration.
5. Set the maximum number of displayed results.
Note
If the number of pictures captured by the selected cameras(s) during the selected time duration
exceeds the number of maximum number to be displayed, only the lasted pictures will be
displayed.
For example, if the number of pictures captured by the selected cameras during the selected
time duration is 2000, and the maximum number to be displayed is 1000, only the lasted 1000
pictures will be displayed.
6. Click Search to start searching.
The search results of the pictures are displayed in list.
7. Optional: Perform secondary search based on the search result
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1) Move to the searched picture and click
All the human bodies in this picture will be analyzed and displayed.
2) Select a human body you want to do secondary search.
3) Set the similarity and time period.
4) Click Search.
The client will search and compare the human bodies in the captured pictures based on the
human body picture you selected.
8. Optional: After searching human body, you can do one or more the following operations.
View Details

Click on a picture from the list to view details. You can also click
to show the large picture, and click
to restore.

Play Related Videos

Click Playback to play the picture's related video file (5s before and 5s
after the capture) in the view window on the bottom right.
Note
● You can click
to show the large video, and click
to restore.
● You can click
to adjust the play speed of the playback, click
to play back the video files frame by frame, click
to enable
audio, double‐click the playback window to maximize the window.

Save Pictures to PC

Click Export Picture and select the pictures as desired to export to
local PC.

15.3 View Behavior Analysis Related Pictures and Videos
When the connected device supports behavior search (e.g., line crossing, people gathering and
loitering), you can search the related picture and view the related pictures and video files.
Before You Start
Add the device to the software and properly configure the corresponding settings. See Add Device
for details about adding the camera.
Steps
1. Click Data Retrieval → Behavior Analysis to enter the behavior analysis page.
2. Click
to set the start time and end time for searching the matched pictures.
3. Select a camera in the camera list.
Note
This function should be supported by the connected device (NVR or HDVR).
4. Select event type for behavior analysis report.
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5. Click Search to start searching.
6. Optional: After searching the behavior, you can perform the following operations.
View Details

Click on a picture from the list to view details. You can also click
to show the large picture, and click
to restore.

Play Related Videos

Click Playback to play the picture's related video file (5s before and 5s
after the capture) in the view window on the bottom right.
Note
● You can click
to show the large video, and click
to restore.
● You can click
to adjust the play speed of the playback, click
to play back the video files frame by frame, click
to enable
audio, double‐click the playback window to maximize the window.

Save Pictures to PC

Click Export Picture and select the pictures as desired to export to
local PC.

15.4 Vehicle Retrieval
For the DeepinMind device, you can search the device's captured vehicle pictures by setting the
search conditions, such as plate number, captured time, etc.
Before You Start
Add the device to the software and properly configure the corresponding settings. See Add Device
for details about adding the device.
Steps
Note
This function should be supported by the connected device.
1. Click Data Retrieval → Vehicle Retrieval to enter the vehicle retrieval page.
2. Click
to set the start time and end time for searching the captured vehicle pictures or video
files.
3. Select the search type.
Vehicle
Search and display the captured vehicle pictures by entering the vehicles' license plate
number.
Plate
Search and display the captured license plate number pictures by entering the vehicles'
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license plate number.
Mix‐traffic Detection
Search and display the mix‐traffic detection related pictures of the specific vehicle by entering
the vehicle's license plate number.
Note
The camera should support mix‐traffic detection.
Traffic Violations
Search and display the traffic violation related pictures of the specific vehicle by entering the
vehicle's license plate number.
Note
The camera should support traffic violation.
4. Select device(s) in the camera panel.
5. Enter the keyboard of license plate number for search.
6. Set the maximum number of displayed results.
7. Click Search to start searching.
The search results of the pictures are displayed in list.
8. Optional: Click the picture to view the whole captured picture, the captured time, etc.
9. Optional: Export the picture(s) to the local PC.
– Click Export Picture, and then select the picture to be exported, and then click Export.
– Click Export Current Page to export all the pictures and information on the current page.
– Click Export Segment to download the pictures and capturing information by packages. Each
package contains up to 1000 pictures.
10. Optional: Perform the following operations if needed.
Add to Face Picture
Library

Click Add to face picture library to add current face picture to the
library .

View Detailed
Information

Click View to view the historical captured pictures of this person, the
captured time.

Playback

Click Playback to play back the video of 5‐seconds before and after
the capturing time.

Export

Click the picture to be exported, and then click Export to export this
picture.

15.5 Hard Hat Retrieval
After adding the hard hat detection device to the client, when the device detects a person who
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doesn't wear a hard hat, it will trigger an event and capture some pictures to notify the managers.
You can search the alarm pictures in which the detected person doesn't wear a hard hat. By this
way, you can remind the builders to wear hard hat, thus to improve builders' safety awareness.
Before You Start
Add the device(s) with hard hat detection function to the client.
Steps
1. Click Data Retrieval → Hard Hat Search to enter the hard hat search page.
2. Set the start time and end time for searching.
3. Select the camera for searching.
4. Click Search.
The captured pictures for hard hat alarm is displayed on the right panel. Up to 30 pictures can
be displayed in one page.
5. Perform the following operations if needed.
Export Picture

1. Click Export Picture.
2. Select one or more picture(s), or check Select All on the page
below.
3. Click Export on the page below to export the selected picture(s).

View the Whole
Picture

Click a picture, and then the whole picture and captured time be
displayed in the middle of the page.

Play Back Video

Click a picture, and then click Playback to play back the video of 5‐
seconds before and after the capturing time.

15.6 Frequently Appeared Person Retrieval
The person's captured face picture can be compared with the face pictures in the face picture
library. If mismatched, he/she will be judged as frequently appeared person, and trigger an event
to notify the security person. For example, in some high‐safety demanded scene (e.g. bank), if a
stranger appears frequently, the event can be triggered to notify the security person or related
person. If matched, he/she will be judged as a person in whitelist and will not trigger frequently
appeared person alarm.. You can search the event information in a certain time, such as the
captured pictures, captured time, and you can view the detailed pictures and play back the related
video.
Before You Start
● Make sure the frequently appeared person alarm has been configured on the device.
● Make sure the device has been armed.
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Steps
1. Click Data Retrieval → Frequently Appeared Person to enter the frequently appeared person
page.
2. Set the start time and end time for searching.
3. Select the camera(s) for searching.
4. Click Search.
The frequently appeared person alarm related pictures will be displayed on the right panel.
5. Optional: Click the picture to view the whole captured picture, the captured time, etc.
6. Optional: Export the picture(s) to the local PC.
– Click Export Picture, and then select the picture to be exported, and then click Export.
– Click Export Current Page to export all the pictures and information on the current page.
– Click Export Segment to download the pictures and capturing information by packages. Each
package contains up to 1000 pictures.
7. Optional: Perform the following operations if needed.
Add to Face Picture
Library

Click Add to face picture library to add current face picture to the
library .

View Detailed
Information

Click View to view the historical captured pictures of this person, the
captured time.

Playback

Click Playback to play back the video of 5‐seconds before and after
the capturing time.

Export

Click the picture to be exported, and then click Export to export this
picture.
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Chapter 16 Security Control Panel
A security control panel detects people, vehicle (etc.) entering a pre‐defined virtual region, triggers
events, and reports events information (such as event location) to security personnel. The Event
Center module provides event management and remote control of partitions and zones via the
client. After configuring client actions in event management page, you will receive notifications on
the client when an event occurs. You can also manage the partitions and zones by the client even
if you cannot operate the security control panel mannually.
Note
Permissions are required for Event Management, remote control of security control panel, and
device arming & disarming. For details about setting user permissions, refer to Add User.

16.1 Configure Client Linkage for Zone Event
Even if you are far away from a zone, you can still know what happens and how urgent the event is
in a zone by configuring linked actions of zone event on the client. You will be notified on the
client once an event is triggered, so that you can response to the event instantly. You can also
configure client actions of multiple zones in a batch at a time.
Before You Start
● Make sure you have added a security control panel.
● Make sure zones have been defined beforehand.
● Make sure events have been configured beforehand.
Steps
1. Click Event Management → Security Control Event.
2. Expand the zone list of a security control panel, and then select a zone from the list.
3. Check one or more event.
4. Click Edit Linkage to configure client actions.
Audible Warning
The client software gives an audible warning when an event is triggered. You can select the
alarm sound for audible warning.
Note
Click Add to enter the alarm sound name and select a sound in your PC. For details, refer to
Set Alarm Sound.

Send Email
Send an email of the alarm information to one or more receivers.
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For details about setting email parameters, refer to Set Email Parameters.
Pop‐up Window
Pop‐up window to display the event related information (including event details, captured
pictures of the linked camera, process record, and process field) on the software client when
the event is triggered.
Display on Map
When the event source is added as a hot spot on the map, the hot spot will be displayed with
red number (indicates the number of events, and the maximum number is 10)aside when the
event is triggered, which helps the security guard to view the location of the event.
You can also click the hot spot to view the event details and the live video of the linked
camera (s).
Linked Camera
Link the selected camera(s) to capture picture when the zone event is triggered.
Select the camera(s) in the drop‐down list.
Note
Up to 4 cameras can be selected as the linked cameras for a zone event.
5. Optional: Click Edit Priority to set event priority as Uncatergorized/Low/Medium/High.
6. Optional: Click Copy to... to copy the event settings (including event priority, triggered client
actions, and enabling/disabling the event) to other zones.
7. Enable or disable client actions for zone event.
– Click Enable All or Disable All to enable or disable client actions of all zone events.
– Switch Enable to ON/OFF to enable or disable client actions of one zone event.
Enable Client Actions
When client actions are enabled, client actions will be triggered when client receives zone
event.
Disable Client Actions
When client actions are disabled, client actions will not work and actions will not be triggered
when client receives zone event.
8. Click Save.

16.2 Remotely Control Security Control Panel
After adding the security control panel to the client, you can remotely control the partitions,
zones, and relays of security control panel via the client software. For instance, you can arm,
disarm, bypass, group bypass, etc. for both partitions and zones. You can also enable or disable
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relays.
Note
● The displayed interface is subject to the types of added security control panels.
● By default, axiom hub device uses HTTP port, and it does not support private ports.

16.2.1 Remotely Control Partitions
You can perform operations remotely on security control panel's partitions using the client such as
away arming, stay arming, instant arming, disarming, clearing alarm, group bypass, and recovering
group bypass.
Steps
Note
● The supported functions are subject to the added devices.
● If a zone of a partition does not work, you should bypass it before arming/disarming the
partition, and then recover bypass when the zone works.
1. Click Event Center → Security Control Panel.
2. Select a security control panel and click Partition.
The name, status, arming status and linked zone of the partitions will be displayed in the list.
3. Select one or more partition and click the following button(s).
Away Arming
An arming mode that works when all persons are absent from the monitored region. When
away arming is enabled, all zones of the partition work properly.
Stay Arming
An arming mode that works when persons stay in the monitored region. When stay arming is
enabled, zones inside of the region are armed while zones outside of the region will be
bypassed where you can move in the zones without triggering any event.
Instant Arming
After arming a partition, its zone will alarm instantly when an event is triggered.
Disarming
All the zones (except 24‐hour zones) in the partitions does not work any more after clicking,
so that no event will be triggered in the disarmed zones.
Note
24‐hour zones (e.g. 24‐hour annunciating zones, 24‐hour silent alarm zone, etc.) still can
detect events and then alarm even if the partition is disarmed.
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Clear Alarm
Stop the alarming of alarming devices.
Group Bypass
Bypass all the zones in one or more partition so that no event will be triggered in the
bypassed zones before group bypass recovery.
Note
You should disarm the partition before bypassing it.

Group Bypass Recovery
Recover a group bypass to make all the zones in a partition work, so that you can arm the
group.

16.2.2 Remotely Control Zones
You can use the client to remotely control the security control panel's zones including bypassing
and recovering bypass.
Steps
1. Click Event Center → Security Control Panel.
2. Select a security control panel and click Partition.
The name, status, arming status and linked zone of the partitions will be displayed in the list.
3. Click
to open the Zone Operation panel.
The zones linked with the partition, zone No., zone name, zone status, zone alarm status,
battery will be displayed.Zone Status
Zone status can be unassociated, armed, disarmed, fault, shield, tamper‐proof, etc.
Battery
The power of a zone's detector.
4. Check one or more zone in the list and click the following buttons.
Bypass
When a zone is bypassed, no event will be triggered in the zone, and you are not allowed to
arm or disarm the zone, while other zones can be armed or disarmed.
Note
You should disarm the zone before bypassing it.

Bypass Recovery
After recovering bypass for a zone, you can arm it.
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16.2.3 Remotely Control Relay
You can use the client to remotely change the on/off status of relay, and view the linked event of
the relay.
Steps
1. Click Event Center → Security Control Panel.
2. Select a security control panel, and then click Relay.
The name, status, and linked event of the relay will be displayed.
3. Check one or more relay and click Open or Close.
Note
For Axiom Hub, you should set the Relay Associated Event as Manual Control in Device
Management module.
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Chapter 17 Log Search
Two log types are provided: operation log and system log. The operation logs refer to the normal
operations that the user did on the client, such as add device, reset password, and start live view;
and the system logs record the system information, such as login, logout, log and unlock. You can
search the log files and view the log details, including time, user, etc.
Perform the following steps to search the log files.
Steps
1. Enter the Log Search module.
2. Click
to specify the start time and end time.
Note
You can search the logs within one month.
3. Select a user to search the log files which are generated when this user log into the client.
4. Select Operation Log or System Log as log type.
5. Click Search.
The log files between the start time and end time will be displayed on the list. You can check the
operation time, type and other information of the logs.
6. Optional: Perform the following operations if there are too many log files.
Filer

Click

on each table header and select to filter the logs.

Sort

Click the table header to sort the logs by the time or letter sequence.
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Chapter 18 User Management
To improve the system security, the administrator should create different account for different
user, and assign different permissions to the user. To avoid different people sharing the same user
account, we recommend you manage the user accounts periodically.

18.1 Add User
The super user and administrator can add new users, and assign different permissions for different
users if needed.
Perform this task to add an user account.
Steps
Note
The user account you registered to log in the software is set as the super user.
1. Enter the User Management module.
2. Click Add User to show user information area.
3. Select the user type from the drop‐down list.
Administrator
The administrator account has all permissions by default, and can modify the passwords and
permissions of all operators and its own.
Operator
The operator account has no permission by default and you can assign the permissions
manually. An operator can only change the passwords of its own account and the accounts
which are added by it.
4. Enter the user name, password, and confirm password as desired.
Caution
The password strength of the device can be automatically checked. We highly recommend you
change the password of your own choosing (using a minimum of 8 characters, including at least
three kinds of following categories: upper case letters, lower case letters, numbers, and special
characters) in order to increase the security of your product. And we recommend you reset your
password regularly, especially in the high security system, resetting the password monthly or
weekly can better protect your product.
Proper configuration of all passwords and other security settings is the responsibility of the
installer and/or end‐user.
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5. Check the checkboxes to assign the permissions to the created user.
6. Optional: Click Default Value to restore the default permissions of this user.
7. Click Save.
Note
Up to 50 user accounts can be added for the client software.
After created user account successfully, the user account is added to the user list on the
Account Management page.
8. Optional: Perform the following operations after the user account is created.
Edit User

Click a user from the list to edit the user information.
Note
Only the password of the super user can be edited.

Delete User

Select the user from the list and click Delete User.
Note
You cannot delete the super user.

18.2 Change User's Password
The administrator can change normal user's password without entering the old password, while
the administrator should enter the old password when changing the password of itself.
Before You Start
Add user to the software client.
Steps
1. Enter the User Management module.
2. Select the user need to be change password, click Change.
3. Optional: Enter the old password.
Note
When changing the administrator's password, you need to enter the old password first.
4. Enter the new password and confirm the password.
5. Click OK.
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Chapter 19 System Configuration
The system parameters, including general parameters, live view and playback parameters, image
parameters, file saving paths, etc., can be configured.

19.1 Set General Parameters
You can configure the frequently‐used parameters, including log expired time, network
performance, etc.
Steps
1. Enter the System Configuration module.
2. Click General tab to enter the General Settings page.
3. Configure the general parameters.
Log Expiry Date
The time for keeping the log files. Once exceeded, the files will be deleted.
Maximum Mode
Select Maximize or Full Screen as the maximum mode. Maximize mode can maximize the
display and show the taskbar. Full Screen mode can display the client in full‐screen mode.
Network Performance
Set the network conditions to Normal, Better or Best.
Enable Keyboard and Joystick
Enable the keyboard or joystick. After enabled, you can set the shortcuts for the keyboard
and joystick.
Note
For details, refer to Set Keyboard and Joystick Shortcuts.
Detect New Software Version
After enabled, the client can automatically detect the new software version and remind the
user to upgrade the software.
Automatic Time Synchronization
Automatically synchronize the time of the added devices with the time of the PC running the
client at a specified time point.
Auto‐Upgrade Device
Set the upgrading mode after the new version of device are detected.
Disable
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After enabled, the client will not download the firmware package and upgrade even if the
client detects a new version of the client.
Prompt Me If Download and Upgrade
After the client detects a new version of the device, it will prompt the user whether to
download the firmware package and upgrade.
Download and Prompt Me If Upgrade
After the client detects the new version of the device, it will download the firmware
package automatically, and prompt the user whether to upgrade.
Download and Prompt Automatically
After the client detects the new version of the devices, it will download the firmware
package and upgrade the new version automatically.
You need to set a schedule in the Upgrade Time field, during which the client upgrades the
new version automatically.
Cloud P2P Region
Select the server's region for cloud P2P, you can select the region you belong to or the
nearest region around.
4. Click Save.

19.2 Set Live View and Playback Parameters
You can set the parameters for live view and playback, including picture format, pre‐play duration,
etc.
Steps
1. Enter the System Configuration module.
2. Click Live View and Playback tab.
3. Configure the live view and playback parameters.
Picture Format
Select JPEG or BMP as the image format for storing pictures.
Note
If Display Temperature on Captured Pictures switch is set to ON, JPEG is selected as the
image format by default and cannot be changed.
Merge Downloaded Video Files
Set the maximum size of merged video file for downloading the video file by date.
Search Video Files Stored in
Search the video files stored in the local device, in the storage server, or both in the storage
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server and local device for playback.
Pre‐play for
Set the pre‐play time for event playback. By default, it is 30s.
Prioritize Playback of Video Files on Storage Server
Play back the video files recorded on the storage server preferentially. Otherwise, play back
the video files recorded on the local device.
Resume Latest Live View Status After Restart
Resume the latest live view status after you log into the client again.
Disconnect Background Videos in Single Live View
In multiple‐window division mode, double‐click a live video to display it in 1‐window division
mode, and the other live videos will be stopped for saving the resource.
Enable Wheel for Zoom
Use the mouse wheel for zoom in or out of the video in PTZ mode, or for zoom in or restoring
of the video in digital zoom mode. In this way, you can directly zoom in or out (or restore) the
live video by scrolling the mouse.
Skip Unconcerned Video during VCA Playback
Skip the unconcerned video during VCA playback and the unconcerned video will not be
played during VCA playback.
4. Click Save.

19.3 Set Image Parameters
The image parameters of the client can be configured, such as view scale, play performance, etc.
Steps
1. Open the System Configuration page.
2. Click Image tab to enter the Image Settings interface.
3. Configure the image parameters.
View Scale
The view scale of the video in live view or playback. It can be set as Full Screen, 4:3, 16:9, or
Original Resolution.
Note
You can also set the view scale in Live View module. For details, refer to Live View.
Play Performance
The play performance of the live video. It can be set as Shortest Delay, Balanced, or Fluency.
You can also select Custom and specify the frames according to actual needs.
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Auto‐change Stream Type
Change the video stream (main stream or sub‐stream) automatically in live view according to
the size of the display window.
Note
When the window division is larger than 9, it will switch to sub‐stream automatically.
Hardware Decoding Preferred
Set to enable decoding by hardware for live view and playback. Hardware Decoding can
provide better decoding performance and lower CPU usage when playing the HD videos
during live view or playback.
Enable Highlight
Mark the detected objects with green rectangles in live view and playback.
Display Transaction Information
Display the transaction information on the live view image.
VCA Rule
Display the VCA rule in the live view.
Enable Frame Extracting for High‐speed Playback
When play back the video in high‐speed (8x speed and above), you can disable this function
to make the image of playback more fluent to view the details.
Display Target's Pattern
After enabled, you can view the target person's motion track on the view window.
The device should support this function.
Overlay Rules on Captured Picture
For the thermal device, set to display the temperature information and fire source
information on the captured pictures.
Note
After enabled this function, the Picture Format in System Configuration → Live View and
Playback will change to JPEG and is not editable.
4. Click Save.
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19.4 Set Picture Storage
The captured pictures triggered by the events on the devices, can be saved in the PC running the
Mira Service. The picture storage location can be manually set.
Steps
1. Enter the System Configuration module.
2. Click Event Picture Storage.
3. Set the Store Pictures in Server switch to on.
All the disks of the PC running the service will show.
4. Select the disk to save the pictures.
Note
The default saving path is: Disk/MiraalarmPicture
5. Click Save.

19.5 Set Alarm Sound
When the event, such as access control event, is triggered, the client can be set to give an audible
warning and the sound of the audible warning can be configured.
Steps
1. Open the System Configuration page.
2. Click Alarm Sound tab to enter the Alarm Sound Settings page.
3. Optional: Click
and select the audio files from the local path for different events.
4. Optional: Add customized alarm sound.
1) Click Add to add customized alarm sound.
2) Double click the Type field to customize the alarm sound name as desired.
3) Click
and select the audio files from the local path for different alarms.
5. Optional: Click
for a testing of the audio file.
6. Optional: Click
in the Operation column to delete the custom sound.
7. Click Save.
Note
The format of the audio file can only be WAV.
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19.6 Set Access Control and Video Intercom Parameters
You can configure the access control and video intercom parameters according to actual needs.
Steps
1. Open the System Configuration page.
2. Click the Access Control & Video Intercom tab.
3. Input the required information.
Ringtone
Click and select the audio file from the local path for the ringtone of indoor station.
Optionally, you can click for a testing of the audio file.
Max. Ring Duration
Specify the seconds that the ring will last for at most. The maximum ring duration can be set
from 15s to 60s.
Max. Speaking Duration with Indoor Station
Specify the seconds that the call with indoor station will last for at most. The maximum
speaking duration between indoor station and the client can be set from 120s to 600s.
Max. Speaking Duration with Door Station
Specify the seconds that the call with door station will last for at most. The maximum
speaking duration between door station and the client can be set from 90s to 120s.
Max. Speaking Duration with Access Control Device
Specify the seconds that the call with access control device will last for at most. The
maximum speaking duration between access control device and the client can be set from
90s to 120s.
4. Click Save.

19.7 Set File Saving Path
The video files from manual recording and the captured pictures are stored on the local PC. The
saving paths of these files can be set.
Perform the following task when you need to set the file saving path.
Steps
1. Open the System Configuration page.
2. Click File tab to enter the File Saving Path Settings page.
3. Click
and select a local path for the files.
4. Click Save.
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19.8 Set Icons Shown on Toolbar
The icons and the order on the toolbar in the live view and playback window can be customized.
You can set to display what icons and set the icon order.
Perform the following task when you need to set icons shown on Toolbar.
Steps
1. Enter the System Configuration module.
2. Click Toolbar tab to enter the Toolbar Settings page.
3. Set Enable Screen Toolbar Display switch to ON to enable displaying the toolbar on in the live
view and playback window.
4. Click the required icon to display on the toolbar.
5. Optional: Drag the icon to set the icon order when displaying on the toolbar.
Table 24‐1 Icons on Live View Toolbar
Stop Live View

Stop the live view in the display window.

Capture

Capture the picture in the live view process. The capture
picture is stored in the PC.

Record

Start manual recording. The video file is stored in the PC.

PTZ Control

Start PTZ mode for speed dome. Click and drag in the
view to perform the PTZ control.

Two‐way Audio

Start the two‐way audio with the device in live view.

Digital Zoom

Enable the digital zoom function. Click again to disable
the function.

Instant Playback

Switch to the instant playback mode.

Remote Configuration

Open the remote configuration page of the camera in
live view.

Table 24‐2 Icons on Playback Toolbar
Capture

Capture the picture in the live view process. The capture
picture is stored in the PC.

Record

Start manual recording. The video file is stored in the PC.

Digital Zoom

Enable the digital zoom function. Click again to disable
the function.

Download

Download the video files of the camera and the video
files are stored in the PC.

VCA Playback

Set the VCA rules. For more details, refer to VCA
Playback.
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Tag Control

Add default or custom tag for the video files to mark the
important video point. You can also edit the tag.

6. Click Save.

19.9 Set Keyboard and Joystick Shortcuts
The keyboard can be connected to the client and be used to control the PTZ cameras. You can set
the shortcuts for keyboard and joystick to get quick and convenient access to the commonly used
actions.
Perform this task when you need to set keyboard and joystick shortcuts.
Steps
Note
This configuration page will display after enabling keyboard and joystick in General Settings. For
details, refer to Set General Parameters.
1. Enter the System Configuration module.
2. Click Keyboard and Joystick to show the Keyboard and Joystick Shortcut Settings area.
3. Select the COM port from the drop‐down list for keyboard if the keyboard is connected to the
PC installed with the client.
Note
You can enter the Device Manger of the PC to check the COM port, which the keyboard is
connected to.
4. Set shortcuts for keyboard and joystick.
1) Select a certain function name on Function column.
2) Double‐click the item field under the PC Keyboard, USB Joystick or USB Keyboard column.
3) Select the compound keys operation or number from the drop‐down list to set it as the
shortcuts for the function of the keyboard or USB joystick.
5. Click Save.
Example
For the Focus (+) function, if you set Home, 1, and F1 as the shortcuts of the PC Keyboard, USB
Joystick and USB Keyboard, you can press the Home key on PC keyboard, control the joystick to
the 1 direction, or press F1 key on USB keyboard to zoom in.
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19.10 Set Email Parameters
An email notification can be sent when an event occurs. To send the email to some specified
receivers, the settings of the email need to be configured before proceeding.
Steps
1. Enter the System Configuration module.
2. Click Email tab to enter the Email Settings interface.
3. Enter the required information.
STMP Server
The STMP server IP address of host name (e.g., smtp.263xmail.com)
Encryption Type
You can check the radio to select Non‐Encrypted, SSL, or STARTTLS .
Port
Enter the communication port used for SMTP. The port is 25 by default.
Sender Address
The email address of the sender.
Security Certificate (Optional)
If your email server requires authentication, check this checkbox to use authentication to log
into the server and enter the login user name and password of your email account.
User Name
Enter the user name of the sender email address if Server Authentication

is checked.

Password
Enter the password of the sender Email address if Server Authentication is checked.
Receiver 1 to 3
Input the email address of the receiver. Up to 3 receivers can be set.
4. Optional: Click Send Test Email to send an email to the receiver for test.
5. Click Save.

19.11 Manage Security Authentication
For the data security purpose, the security certificate of clients and added servers (stream media
server) should be same. You can set the verify certificate is required or not when enabling
transmission encryption using TLS (Transport Layer Security) protocol.
Before adding the stream media server to the client, you should export the service certificate from
the client service, and import it to the stream media server. If multiple clients use the same server,
you should make the security certificates of the clients and the server same with each other.
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19.11.1 Export Certificate from Service Management
You can export the security certificate from the current client service and import the exported
certificate file to the stream media server or other clients.
Steps
1. Enter the Service Management.
2. Click Export to save the certificate file in the local PC.
Note
The certificate file is in XML format.
What to do next
After exporting the certificate, you can copy the certificate to the PC installed with the client and
import it to the stream media server, or to other clients.
For importing to the stream media server, refer to Import Certificate to Stream Media Server.

19.11.2 Import Certificate to Client
If there are multiple clients accessing the same steam media server, you should import the same
certificate to the clients and server.
Before You Start
Make sure you have exported the security certificate from one of the client service.
Note
For details, refer to Export Certificate from Service Management.
Steps
1. Copy the certificate file exported from other client to the local PC.
2. Enter the System Configuration module.
3. Click Security Authentication tab to enter the security authentication setting interface.
4. Click Import.
5. Select the certificate file from your local PC and click Open.
Note
Please restart the client to take effect.
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19.11.3 Certificate Verification for Transmission Encryption
On the Security Authentication page, you can set the device certificate verification is required or
not for transmission encryption.
Click System Configuration → Security Authenticationto enter the security authentication
interface. Select the Verify Certificate as Yes or No.
Yes
You must put the device certificate to the designed directory if you enable transmission
encryption when adding device. And the device will be added with transmission encryption and
the certificate will be verified, which improves the security level.
No
The device certificate is not required if you enable transmission encryption when adding device.
And the device will be added with transmission encryption.
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Chapter 20 Operation and Maintenance
You can perform maintaining operations in the menu to ensure a smooth and convenient usage of
the client.
Click
in the upper‐right corner, and then click File/System/Tool to perform the following
operations.

Open Log File
You can open a log file saved in your local PC or log files of the client.

Import/Export Configuration File
You can import configuration files from local PC to the client if needed, and vice versa.

Auto Backup
Select day and time to backup configuration files and data in database, or restore the backed up
data.

Batch Time Sync
Synchronize selected devices' time with your PC time.

Message Queue
After configuring email linkage, the triggered event(s) will be displayed here. Select an event and
cancel sending the an email to the receiver.

110

Mira

Error Code
Cod
e

Error Name

Description

Mira
317

No videos.

It will be prompted when the user has no permission
to play back.

HCNetSDK.dll
1

Invalid user name or password.

2

No permission.

The user in the device has no enough permission.

4

Invalid channel number.

It will be prompted in the live view of remote screen
control.

5

No more devices can be
connected.

7

Failed to connect the device.

23

Not supported.

29

Operation failed.

43

No buffer.

55

Invalid IP address.

56

Invalid MAC address.

91

The channel does not support
the operation.

96

The device is not registered on
the DDNS.

153

The user is locked.

250

The device is not activated.

404

Channel No. error or the device
does not support the sub
stream.

It will be prompted when failed to get the sub stream
or the sub stream does not exist.

424

Failed to receive the data for
RTSP SETUP.

It will be prompted when adding the live view for the
software DVS via external network.

It will be prompted when adding a device and the
device port is occupied by a web server.

It will be prompted when failed to get the sub stream.
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Cod
e
800

Error Name

Description

No more bandwidth can be
used.

Playctrl.dll
2

The stream is not a Video & Audio stream.

6

The playback window turns black when adopting
H.265 in the 64‐bit operating system.

SMS
3

The connection problem between the software and
the stream media server.

17

The streaming problem between the stream media
server and the device.
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